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About these Release Notes

This section contains the following release notesfor IBM® ILOG® Views:
Release Notes for Version 5.3

Release Notes for Version 5.2

Release Notes for Version 5.1

Release Notes for Version 5.0.1

Corrected Patches Since Version 5.0

Release Notes for Version 5.0

Release Notes for Version 4.0.2

® 6 6 6 o o o

IBM ILOG VIEwWSs V5.3 — RELEASE NOTES 5



IBM ILOG VIEwWS V5.3 — RELEASE NOTES



Release Notes for Version 5.3

Note for users of previous releases of ILOG Views

All known incompatibilities of thisversion of IBM® ILOG® Viewswith previous versions
are described in the file compaT . TXT that you can find in the installation folder.

This can be useful if you have any problems compiling or running your old applications.

New Ports

With this version, support has been added for the following ports:

¢ (a4 hpux1l 6.17: This portisintended to be used on the Itanium® platform running
under HP UX 11.23 or higher. The compiler to be used is a C++ version 6.17 in 64 bits
mode.

¢ ia64-32_hpux11l 6.17: Thisport isintended to be used on the Itanium platform under
HP UX 11.23 or higher. The compiler to be used isa C++ 6.17 in 32 bits mode.

& x64 solaris10 11: Thisport isintended to be used on x86-64 platforms (also called
AMD 64) running under Sun™ Solaris™ 10 or higher. The compiler to be used is Sun
Studio 11 in 64 bits mode.
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& x86_solaris10_11: This port isintended to be used on x86 platforms running under Sun
Solaris 10 or higher. The compiler to be used is Sun Studio 11 in 32 bits mode

& powerbd aix5.2_7.0: Thisport isintended to be used on PowerPC platforms running
under AIX 5.2. The compiler to be used is Visual Age 7.0 in 64 bit mode (option -g64)
using standard C++ streams (-DIL_STD)

Note that on these new ports, only IBM® Informix® and Oracle® are supported.

Changes to Product Icons

Most product icons have been changed to comply with the IBM® look-and-feel guidelines.

Removal of Deprecated Package

The Web Deployment package of IBM® ILOG® Views Component Suite is deprecated and
has been removed in this release.
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Release Notes for Version 5.2

Note for users of previous releases of ILOG Views

All known incompatibilities of thisversion of ILOG Views with previous versions are
described in the file compaT . TXT that you can find in the same directory as this README
file

Please read it if you have any problems compiling or running your old applications.

Technical Support

If you have problems using the ILOG Views libraries and if the documentation set does not
help you fix your problem, please send a bug report to the ILOG support team, using the
template provided in the file BUGREPORT, Or bugreprt . txt if you are using a Windows
platform.

New Features

& Support of S57 map format

e ILOG Views Maps now supports the S57 nautical maps format, a standard published
by the International Hydrographic Organization (IHO).
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& Support semi-transparent PNGs
e PNG images containing semi-tranparent pixel are now supported.
& Easier interactions with Spline objects

e New interactors have been added to permit easier creation and interactions with
spline objects.

New filter effects to simulate different levels of transparency on graphics objects
Ctrl Mouse wheel support for zoom in/out in Studio

M ouse wheel support for up/down movement in spinbox

Ctrl-Tab key can be used for Tab-pane rotation

Generalized use of the ESC key for interrupting object creation interactors

GUI restructuring for Studio. New icons and dialog boxes

® 6 6 6 6 o o

Better support of Windows Vistawith Aero L&F

o Windows Vista has new visual effects and ook and feel elements that are now
supported with ILOG Views.

New samples and documentation for printing
Support of Oracle 10 and Oracle 11 in DataA ccess
Support of DB2 9.5 in Data Access

Support of OLE DB in DataAccess

Port on VS 2008

Integration of all bug fixes since version 5.1

® & 6 6 6 o o

Other minor fixes and evolutions

Compilation
ILOG Viewsis delivered with aset of libraries that are stored in a directory that depends on

the type of machine you are using, the operating system it runs on and the compiler you plan
to use.
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Compilation

This directory can be one of:

System name Hardware Operating System Compiler
alpha_5.1_6.5 HP/Compaqg (DEC) | Tru64 UNIX (OSF1) V5.1 |C++ 6.5 or higher
Alpha or higher
hp32_11_3.73 HP 9700 HP-UX 11.11 or higher HP ANSI C++ A.03.73 or
higher using -mt -AA options
hp64_11_3.73 HP 9700 HP-UX 11.11 or higher HP ANSI C++ A.03.73 or
higher in 64bit mode
(+DA2.0W) using -mt -AA
options
ia64_hpux1l_6.17 IA-64 HP-UX 11i v3 HP C++/ANSI A.06.17 in 64
bit mode
x86_RHEL4.0_3.4 x86 RedHat Enterprise Linux | gcc3.4
4.0 (linux 2.4, glibc 2.3)
x86-64_RHEL4.0_3.4 |x86-64 RedHat Enterprise Linux |gcc3.4
4.0 (linux 2.4, glibc 2.3)
x86_sles10.0_4.1 x86 SUSE Linux Enterprise gccd.l
Server 10 (linux 2.6, glibc
2.4)
x64_solaris10_11 x86-64 Solaris 10 Sun C++ 5.8 (aka Sun One
Studio 11) in 64 bit mode
x86_solaris10_11 x86 Solaris 10 Sun C++ 5.8 (aka Sun One
Studio 11)
x86_.net2003_7.1 x86 Windows Server 2003/ XP | Microsoft Visual C++ .NET
/ Vista 2003 (7.1)
x86_.net2005_8.0 x86 Windows Server 2003/ XP | Microsoft Visual C++ .NET
/ Vista 2005 (8.0)
x86_.net2008_9.0 x86 Windows 2000/Server Microsoft Visual C++ .NET
2003/XP/Vista 2008 (9.0)
x64_.net2008_9.0 x64 Windows (64) Server 2003 | Microsoft Visual C++ .NET
/ XP [ Vista 2008 (9.0 - 64 bits)
rs6000_5.1_6.0 RS6000 AIX 5.1 or higher Visual Age 6.0 using
standard C++ streams (-
DIL_STD)
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System name

Hardware

Operating System

Compiler

power32_aix5.2_7.0

PowerPC

AIX 5.2 or higher

Visual Age 7.0 using
standard C++ streams (-
DIL_STD)

ultrasparc32_8 6.2

Sun Ultra Sparc

Solaris 2.8 or higher

Sun C++ 5.3 (Forte 6.2) or
higher

ultrasparc64_8 6.2

Sun Ultra Sparc

Solaris 2.8 or higher

Sun C++ 5.3 (Forte 6.2) or
higher in 64bit mode (-
xtarget=ultra -xarch=v9)

ultrasparc32_10_11 Sun Ultra Sparc Solaris 10 Sun C++ 5.8 (aka Sun One
Studio 11)
ultrasparc64_10_11 Sun Ultra Sparc Solaris 10 Sun C++ 5.8 (aka Sun One

Studio 11) in 64bit mode (-
xtarget=ultra -xarch=v9)

It will bereferred to as <system> in the following text. You may need to change the
provided makefiles to match your own installation requirements:

€ VIEWSDIR must be set to the directory where you unpacked the product (usualy /usr/
ilog/viewsxx on Unix or c:\ilog\viewsxx on Windows, where xx indicates the
current version of ILOG Views);

¢ x1NC and x1.1BS should be set to the directory where your x11 include and lib
directories are located (only on Unix platforms);

& M1INC and ML.IBS should be set to the directory where your Motif include and lib
directories are located (only on Unix platforms).

Platforms no Longer Supported

System name

Operating System

Compiler

Replaced by

mode (+DA2.0W) with-mt -
AA options

hp32_11_3.52 HP-UX 11 C++ A.03.52 with -mt -AA | hp32_11_3.73 requiring HP
options ANSI C++ A.03.73 using -mt
-AA options
hp64_11_3.52 HP-UX 11 C++ A.03.52 in 64bit hp64_11_3.73 requiring HP

ANSI C++ A.03.73 in 64bit
mode (+DA2.0W) with-mt -
AA options

12
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Incompatibility with Version 5.1

System name

Operating System

Compiler

Replaced by

ia64_hpux11l 5.52

HP-UX 11

HP C++/ANSI A.05.52

Not replaced

NT/2000/XP

ia64 RHEL3.0_3.2 RedHat Enterprise |gcc3.2 Not replaced
Linux 3.0 (linux 2.4,
glibc 2.3)
x86_RHEL3.0_3.2 RedHat Enterprise |gcc3.2 x86_RHEL4.0_3.4, requiring
Linux 3.0 (linux 2.4, RedHat Enterprise Linux 4.0
glibc 2.3) (or compatible), glibc2.3 and
gcc3.4, or
x86_sles10.0_4.1, requiring
Suse 10.0 (or compatible),
glibc2.4 and gcc4.1
ppc_linux2_glibc2.3_g |Linux 2.4, glibc 2.3 |gcc3.2 Not replaced
cc3.2
msvc7 Windows 95/98/Me, | Microsoft Visual Studio x86_.net2003_7.1 (or

C++ .NET Standard 2002
(7.0)

x86_.net2005_ 8.0 or
x86_.net2008_9.0) requiring
Windows XP / Vista and
Microsoft Visual C++ .NET
2003 (or 2005 or 2008)

Incompatibility with Version 5.1

Theclass I11vMakePolyPointsInteractor and its subclasses:

The method

virtual void react(IlvPoint& p,

I1UShort modifier =

0);

now has one extra argument that contains the configuration of the keyboard modifiers when
the event that generated the addition of a point was triggered. This extra argument enables
the overriden methods to position the point depending on these modifiers.

Whileit is highly unlikely that this method has been overridden, if thisisthe case, a
compile-time error will occur. In this case, the derived method's signature should simply be
extended to include this extra argument.

IBM
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Execution Requirements

You need to set the environment variable 11.vHOME to the directory where the product has
been installed to ensure that every provided binary works properly. Usually, you will set:

(cshitcsh):
% setenv ILVHOME /usr/ilog/viewsXX
(sh/bash):

$ ILVHOME=/usr/ilog/viewsXX
S export ILVHOME

(Windows Server 2003/XP/Vista):

C:\> set ILVHOME=C:\ILOG\VIEWSXX

Please check with your system administrator the exact location where ILOG Viewsis
installed.

Library Build Information (Unix platforms only)

14

If aproblem occurs while running your applications, you can retrieve the information on the
platform that was used to build the library by using the shell script called ilvversion.sh,
located in the ILOG Views root directory.

Go into the specific static subplatform subdirectory of 1ib and type:
../../../ilvversion.sh

Two lines that have the following form will be printed out (these lines may be swapped):

llvVersion: X.X

IlvBuild: OS - platform - compiler - display revision

The shell script locates the strings 'T11vBuild' and 'T1vversion'inthelibrary file
libxviews.a and prints out the result.

If you have installed multiple platformsin the directory ILVHOME, you can check each of
the platforms:

$ cd SILVHOME
$ ./ilvversion.sh platform

where platform is the system identifier of the ILOG Views library (that is, the <system>,
oneof hp32_11_3.73, power32_aix5.2 7.0, and so on).
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Contents

Contents

ILOG Views Studio

A ready-to-use version of ILOG Views Studio, delivered asabinary file called ivEstudio
isprovided inthe studio/<system> directory. ILOG Views Studio isa GUI builder that
will help you create and generate ILOG Views applications.

Directories

& data/ilviews: containsthe datafiles used by the library (inspector panels, message
databases, and so on).

data/images: containsimage datafiles.
data/icon: contains someicons.

data/DCwW: contains some DCW-generated files.

* & & o

bin: contains binary files, along with source code. The ReaDME file in the bin directory
explains how to build these binary files. Two useful programs can be built in
<ILVHOME>/bin/<system>: ilv2data, which can build a"resourcefile" that can be
linked with your application in order to make it environment-independent. splitdom,
which converts pre-3.0 message databases into the new format, including the new
language definition and encoding.

& samples: contains samplefiles. You can read the README file by clicking here. For each
sample, you need to go to the platform directory and run the make utility to build it.

& tools: contains more specific solutions to common problems.

ILOG Views Data Access: Known Incompatibilities with Version 5.2

Data Access 5.2 is source-compatible with Data Access 5.0 (with the exception of the Open
Ingres database). Binary compatibility, however, is not granted. C++ code must be
recompiled and programs must be relinked because the header files have been modified (for
example, to support new databases).

Note that source compatibility concerns only the documented API (with the exception of
APIs of databases no longer supported). Data Access 5.2 supports Oracle 9i, 10g and 11g
(but it does not support Oracle 8.x and Open Ingres).
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Licensing

If you have afilecalled $ ILVHOME /access.ilm on Unix or $ILVHOME%\access.ilm 0N
Windows, then thisis an evaluation copy of ILOG Views.

You must set the environment variable TL.OG_LICENSE_FILE to this path name to run the
ILOG Views applications:

(cshitcsh):

% setenv ILOG_LICENSE FILE $ILVHOME/access.ilm

]

(sh/bash):

$ ILOG_LICENSE_FILE=$ILVHOME/access.ilm
$ export ILOG_LICENSE_FILE

(Windows Server 2003/XP/Vista):

C:\> set ILOG_LICENSE_FILE=%ILVHOME%\access.ilm

Various Versions
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The libraries are stored in subdirectories of the directory 1ib/<system> on Unix and
lib\<system> on Windows (Server 2003/XP/Vista).

There are several library files (static and shared equivalent):
Unix platforms:

¢ libxviews: Pure Xlib code of ILOG Views.

¢ libmviews: Motif-dependent code of ILOG Views.
Windows Server 2003/XP/Vista platforms:

€ winviews.1lib: Windows-dependent code of ILOG Views.

For al platforms (the name should be prefixed with 1ib on Unix platforms, and have the
. 1ib extension on Windows platforms):

& Foundation Package
e ilog: ILOG utility classes (arrays, lists, and so on).
e views: Corelibrary. Includes Standard 2D graphics.

e ilvgadgt: Core Gadgetslibrary.

Thislibrary is provided with the Foundation Package, but can be used and deployed
only if you have the "ILOG Views' or "ILOG Views Controls" license. Thislibrary
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Various Versions

contains the following classes. 11vMessageLabel, I1vFrame, I1vButton,
IlvToggle, I1lvColoredToggle, I1vComboBox, I1vTextField,
IlvNumberField, I1vPasswordField, I1vPopupMenu, I1vToolBar
IlvMenuBar, I1vScrollBar, I1lvSlider, I1vGadgetItem, I1vMenultem,
IlvGadgetContainer, IlvScrolledView, IlvDialog, I1vIMessageDialog,
IlvIiInformationDialog, I1lvIErrorDialog, IlvIWarner,
IlvIQuestionDialog, I1lvGadgetContainerRectangle,
IlvSCGadgetContainerRectangle, I1vSCViewRectangle

ilvmlook: Motif Look and Feel library.
ilvwlook: Windows 3.11 Look and Feel library.
ilvw951look: Windows 95 Look and Fedl library.
ilvwxplook: Windows XP Look and Feel library (Windows only).
ilvprint: Printing support library.

ilvbmpflt: Bitmap Filterslibrary.

ilvbmp: BMP bitmap streamer.

ilvwbmp: WBMP bitmap streamer.

ilvpng: PNG bitmap streamer.

ilvipg: JPG bitmap streamer.

ilvppm: PBM-PPM bitmap streamer.

ilvtiff: TIFF bitmap streamer.

ilvrgb: SGI RGB bitmap streamer.

iljs: ILOG Script library.

ilvis: ILOG Views Script implementation.
iljsgide: ILOG Script debugger interface.

ilvbuild: Resource-handling classes for binaries.

Gadgets Package (Controls)

ilvadvgdt: Advanced Gadgets library (IlvMatrix, IlvTreeGadget, ...).
ilvadvgadmgr: Manager classes using advanced gadgets.

ilvatext: llIVAnnotext and related classes.

ilvedit: Inspector classes (Color chooser, Font chooser, ...).
ilvstates: Stateslibrary.

ilvamlook: Advanced Motif Look and Fedl library.
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e ilvawlook: Advanced Windows 3.11 Look and Fedl library.
e ilvaw95look: Advanced Windows 95 Look and Feel library.
e ilvawxplook: Advanced Windows XP Look and Feel library (Windows only).
e ilvprtdlg: Printing dialogslibrary.
& Application Framework Package (Controls)
e ilvappframe: Application Framework library.

e ilvappmgr: Application Framework classes using the Manager package
(11vDvManagerDocument and related classes).

e ilvappgrapher: Application Framework classes using the Grapher package
(11vDvGrapherDocument and related classes).

e ilvappwizard: Application Framework library for wizard.
& Manager Package (2D Standard)
e ilvmgr: Manager library (11vManager and related classes).

e ilvgadmgr: Manager classes using gadgets (I1vGadgetManager and related
classes).

e ilvmgrprint: Manager Printing support library.
¢ Data Access Add-On
e dataccess: Core Data Accesslibraries (was'inform' in ILOG InForm 3.0).
e dbaccess: Relational databases libraries (was'dbinform'in ILOG InForm 3.0).
e dbchart: Charts-based Data Access classes library.
e dbgadget: Gadgets-based Data Access classes library.
e dbgantt: Gantt Chart-based Data Access classes library.
e dbgraphe: Grapher-based Data Access classes library.
e dbsglgad: Relational Databases Gadgets classes library.
& Grapher Package (Advanced 2D)
e ilvgrapher: Grapher library (11vGrapher and related classes).
e ilvgadgraph: Grapher classes using gadgets (11vsCGrapherRectangle).
& Prototypes Package (Advanced 2D)
e ilvproto: Prototypes Baselibrary.

e ilvgdpro: Prototype classes using gadgets.
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Using Shared Libraries

& Web Deployment Package (Advanced 2D)

e ilvweb: Web Deployment library.
¢ ChartsAdd-On

e ilvcharts: Chartslibrary (11vChartGraphic and related classes).
¢ Graph Layout Add-On

e ilvlayout: Core Graph Layout library.

e ilvbus: Buslayout library.

e ilvhierarchical: Hierarchical layout library.

e ilvorthlink: Orthogonal Link layout.

e ilvrandom: Random layout library.

e ilvtree: Treelayout library.
¢ Gantt Add-On

e ilvgantt: Gantt Chart library (I11vGanttChart and related classes).
& MapsAdd-On

e ilvmaps: Core Mapslibrary.

e ilvdbmaps: Database-based mapslibrary.

Using Shared Libraries

ILOG Views libraries are provided in both static and shared mode on all platforms (please
see the next section for Unix Users and Motif-based libraries).

If you use shared libraries on a Unix platform, make sure the dynamic loader can find the
ILOG Viewslibraries. You do that by setting the environment variable LD_LIBRARY PATH
(or suLIB_PATH On HP platforms or LIBPATH On ATx platforms) to $ILVHOME/1ib/
<system>/<shareDir>.

If you use shared libraries on a Windows platform, make sure that the system will actually
access the ILOG Views DLLs. Check the system documentation for more information.
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Note for Unix Users

On Unix platforms, when you plan to link your application with ILOG Views, you have to
decide whether or not it will include pure Motif code. If thisis the case, then you need to
link with 1ibmviews.

If you need your application to be a pure Xlib application, then you need to link with

libxviews.

Never link with both, and always link with one of these two. The library "views" islikely to
be necessary for every application.

Important Note About Motif and Shared Libraries
The use of 1ibmviews (Motif based) is deprecated in shared library format.

Since version 4.0, al shared libraries provided by ILOG Views are built using 1ibxviews
and areincompatible with 1ibmviews. 1ibmviews iSonly provided as astatic library and
can only be used with the static version of other ILOG Views libraries.

Note for Windows Server 2003/ XP / Vista Users

Thelibraries are provided in severa versions on the Windows versions that are provided in
subdirectories of 1ib\<system>. Thisis dueto different versions of the run-time system
libraries and to the DLL. Each version needs specific compiler flags as described below:

¢ x86_.net2003_7.1:

e stat_sta: Staticlibrary in single thread with static run-time library using new
|OStreams. Flags: /Gx /GR /ML /DIL_STD (Single Threaded).

e stat_mta: Static library in multithread with static run-time library using new
|OStreams. Flags: /Gx /GR /MT /DIL_STD (Multithreaded).

e stat_mda: Static library in multithread with dynamic run-time library using new
|OStreams. Flags: /Gx /GR /MD /DIL_STD (Multithreaded DLL).

e dl1_mda: Dynamic library in multithread with dynamic run-time library using new
|OStreams. Flags: /Gx /GR /MD /DIL_STD /DILVDLL (Multithreaded DLL).

¢ x86_.net2005_8.0, x86_.net2008_9.0 and x64_.net2008_9.0:

e stat_mta: Staticlibrary in multithread with static run-time library using new
|OStreams. Flags: /EHsc /GR /MT /DIL_STD (Multithreaded).

e stat_mda: Static library in multithread with dynamic run-time library using new
IOStreams. Flags: /EHsc /GR /MD /DIL_STD (Multithreaded DLL).
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Note for Microsoft Visual C++ Users

e dl1_mda: Dynamic library in multithread with dynamic run-time library using new
|OStreams. Flags: /EHsc /GR /MD /DIL_STD /DILVDLL (Multithreaded DLL).

Notes:
1. You must also use the flag /pILIsTDH if you want to use ILOG Script in these modes.
2. You must also link with the system librarieswsock32.1ib and imm32.1ib.

Note for Microsoft Visual C++ Users
For all your projects, make surethat wsock32.1ib and imm32 . 1ib are specified in the link
command line.

To debug your program more easily, add the following lines to the section [AutoExpand]
of thefile

x86_.net2003_7.1, x86_.net2005_8.0, x86_.net2008_9.0 or x64_.net2008_9.0:

$INSTALLDIRS\Common7\Packages\Debugger\autoexp.dat

; from Ilog Views

IlvRect =x = <_orig._x,d> y = <_orig._y,d> width = <_w,u> height = <_h,u>
IlvPoint =x = <_x,d> vy = <_y,d>

IlvTransformer =x11 = <_x11,g> x12 = <_x12,g> x21 = <_x21,g> x22 = <_x22,9g> %0
= < x0,9> y0 = <_y0,g>

Theselines|et you display the values of the objects that these classes define (instead of their
address) in the tooltip that appears when the mouse is positioned over avariable.

You may get a series of link errors when using the Visual C++ 6.0 integrated devel opment
environments to build your project in Debug mode.

In Debug mode, to be able to link your application with Visual C++ and the libraries
provided in ILOG Views, follow these instructions:

x86_.net2003_7.1, x86_.net2005_8.0, x86_.net2008_9.0 or x64_.net2008_9.0:

e inMicrosoft Visual Studio.NET, select your projectsin the " Solution Explorer”
window,

o right-click on the selection and choose the "Properties” item,

o inthe"Property Pages' window, select "Configuration Properties’ -> "C/C++" ->
"Preprocessor",

o inthe"Preprocessor Definitions' field, remove” DEBUG",

o recompile and relink the application.
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Release Notes for Version 5.1

Note for users of previous releases of ILOG Views

All known incompatibilities of thisversion of ILOG Views with previous versions are
described in the file compaT . TXT that you can find in the same directory as this README
file

Please read it if you have any problems compiling or running your old applications.

Technical Support

If you have problems using the ILOG Views libraries and if the documentation set does not
help you fix your problem, please send a bug report to the ILOG support team, using the
template provided in the file BUGREPORT, Or bugreprt . txt if you are using a Windows
platform.

Compilation

ILOG Viewsisdelivered with aset of libraries that are stored in a directory that depends on
the type of machine you are using, the operating system it runs on and the compiler you plan
to use.
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This directory can be one of:

System name

Hardware

Operating System

Compiler

alpha_5.1_6.5 HP/Compaqg (DEC) | Tru64 UNIX (OSF1) V5.1 |C++ 6.5 or higher
Alpha or higher
hp32_11_3.52 HP 9700 HP-UX 11 or higher HP HP ANSI C++ A.03.52 or
higher using -mt -AA options
hp64_11_3.52 HP 9700 HP-UX 11 or higher HP ANSI C++ A.03.52 or

higher in 64bit mode
(+DA2.0W) using -mt -AA
options

ia64_hpux1l_5.52

ia64 (Itanium 2)

HP-UX 11 or higher

HP aC++/ANSI A.05.52 or
higher

ia64_RHEL3.0_3.2 ia64 (Itanium 2) RedHat Enterprise Linux |gcc3.2
3.0 (linux 2.4, glibc 2.3)

x86_RHEL3.0_3.2 x86 RedHat Enterprise Linux |gcc3.2
3.0 (linux 2.4, glibc 2.3)

ppc_linux2_glibc2.3_g | PowerPC Linux 2.4, glibc 2.3 gcc3.2

cc3.2

msvc7 x86 Windows 95/98/Me, or Microsoft C++ 7.0
Windows NT/2000/XP

x86_.net2003_7.1 x86 Windows 95/98/Me, or Microsoft Visual C++ .NET
Windows NT/2000/XP 2003

rs6000_5.1_6.0 RS6000 AIX 5.1 or higher Visual Age 6.0 using

standard C++ streams (-
DIL_STD)

ultrasparc32_8 6.2

Sun Ultra Sparc

Solaris 2.8 or higher

Sun C++ 5.3 (Forte 6.2) or
higher

ultrasparc64_8 6.2

Sun Ultra Sparc

Solaris 2.8 or higher

Sun C++ 5.3 (Forte 6.2) or
higher in 64bit mode (-
xtarget=ultra -xarch=v9)

It will bereferred to as <system> in the following text. You may need to change the
provided makefiles to match your own installation requirements:

€ VIEWSDIR must be set to the directory where you unpacked the product (usualy /usr/

ilog/viewsxx on Unix or c:\ilog\viewsxx on Windows, where xx indicates the
current version of ILOG Views);
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Platforms no Longer Supported

& x1INC and xL.1BS should be set to the directory where your x11 include and lib
directories are located (only on Unix platforms);

& MINC and MLIBS should be set to the directory where your Motif include and lib
directories are located (only on Unix platforms).

Platforms no Longer Supported

options

System name Operating System | Compiler Replaced by
alpha_4_6.1 HP/Compaqg/DEC |C++6.1 alpha_5.1_6.5 requiring
Alpha, OSF1 V4 Tru64 UNIX (OSF1) V5.1 and

C++6.5

2 11 3.05 HP 9700, HP-UX 11 | C++ 3.05 hp32_11_3.52 requiring HP
ANSI C++ 3.52 and -mt -AA
options

hp32_11_3.30 HP 9700, HP-UX 11 | C++ A.03.30 with -mt -AA [ hp32_11_ 3.52 requiring HP

options ANSI C++ 3.52

hp64_11_3.15 HP 9700, HP-UX 11 | C++ A.03.15 hp64_11_3.52, requiring HP
ANSI C++ A.03.52 and -mt -
AA options

hp64_11_3.39 HP 9700, HP-UX 11 | C++ A.03.15 with -mt -AA | hp64_11_3.52, requiring HP

ANSI C++ A.03.52

i86_linux2_glibc2.2_gc |i86, Linux 2.4, glibc |gcc3.0.2 x86_RHEL3.0_3.2, requiring

c3.0 2.2 RedHat Enterprise Linux 3.0
(or compatible), glibc2.3 and
gce3.2

i86_linux2_glibc2.3_gc |i86, Linux 2.4, glibc | gcc3.2 x86_RHEL3.0_3.2, requiring

c3.2 2.3 RedHat Enterprise Linux 3.0
(or compatible), glibc2.3 and
gce3.2

rs6000_4.3_3.6 RS6000, AIX 4.3.2 | CSet++ 3.6 rs6000_5.1_6.0 requiring AIX
5.1, Visual Age 6.0 and
standard C++ streams (-
DIL_STD)

sparc_5_5.0 Sparc, Solaris 2.4 | Sun C++ 5.0 ultrasparc32_8_ 6.2 requiring

Solaris 2.8 and Forte 6.2
(Sun C++5.3)
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System name

Operating System

Compiler

Replaced by

ultrasparc64_5 5.0

Ultra Sparc, Solaris

Sun C++5.0

ultrasparc64_8_6.2 requiring

2.7 Solaris 2.8 and Forte 6.2
(Sun C++5.3)

x86 Windows 95/ Microsoft Visual C++ 6.x | x86_.net2003_7.1 requiring
98/Me or NT/2000/ Microsoft Visual C++ .NET
XP 2003

Execution Requirements

You need to set the environment variable 11.vHOME to the directory where the product has
been installed to ensure that every provided binary works properly. Usually, you will set:

(cshitcsh):
% setenv ILVHOME /usr/ilog/viewsXX
(sh/bash):

$ ILVHOME=/usr/ilog/viewsXX
S export ILVHOME

(Windows 95/98/M e/ Windows NT/2000/XP):

C:\> set ILVHOME=C:\ILOG\VIEWSXX

Please check with your system administrator the exact location where ILOG Viewsis
installed.

Library Build Information (Unix platforms only)

26

If aproblem occurs while running your applications, you can retrieve the information on the
platform that was used to build the library by using the shell script called ilvversion.sh,
located in the ILOG Views root directory.

Go into the specific static subplatform subdirectory of 1ib and type:
../../../ilvversion.sh
Two lines that have the following form will be printed out (these lines may be swapped):

llvWersion: X.X

IlvBuild: OS - platform - compiler - display revision
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Contents

The shell script locates the strings 'T11vBuild' and 'T1vversion'inthelibrary file
libxviews.a and prints out the result.

If you have installed multiple platformsin the directory ILVHOME, you can check each of
the platforms:

$ cd SILVHOME
S ./ilvversion.sh platform

where platform is the system identifier of the ILOG Views library (that is, the <system>,
oneof hp32_11_3.52,rs6000_5.1_6.0, and so on).

Contents

ILOG Views Studio

A ready-to-use version of ILOG Views Studio, delivered asabinary file caled ivfstudio
isprovided in the studio/<system> directory. ILOG Views Studio isa GUI builder that
will help you create and generate ILOG Views applications.

Directories

& data/ilviews: containsthe datafiles used by the library (inspector panels, message
databases, and so on).

data/images: containsimage datafiles.
data/icon: contains someicons.

data/Dcw: contains some DCW-generated files.

* 6 o o

bin: contains binary files, along with source code. The REaDME file in the bin directory
explains how to build these binary files. Two useful programs can be built in
<ILVHOME>/bin/<system>: ilv2data, Which can build a"resourcefile" that can be
linked with your application in order to make it environment-independent. splitdbm,
which converts pre-3.0 message databases into the new format, including the new
language definition and encoding.

¢ samples: contains samplefiles. You can read the REaDME file by clicking here. For each
sample, you need to go to the platform directory and run the make utility to build it.

® tools: contains more specific solutions to common problems.
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ILOG Views Data Access: Known Incompatibilities with Version 5.0

Data Access 5.1 is source-compatible with Data Access 5.0. However, binary compatibility
isnot granted. C++ code must be recompiled and programs must be relinked because the
header files have been modified (for example, to support Oracle 9i).

Note that source compatibility concerns only the documented API. Data Access 5.1 does not
support Oracle 7.3 and Oracle 8.0, but it supports Oracle 9i. Users of Oraclel0.x can usethe
Oracle 9i client to access the Oracle database.

The databases for the ppc_1inux2_glibc2.3_gece3. 2 platform have not been tested as
we do not have any database client for this platform.

Licensing
If you have afilecalled $ ILVHOME /access.ilm on Unix or $ILVHOME%\access.ilm 0N
Windows, then thisis an evaluation copy of ILOG Views.

You must set the environment variable TL.OG_LICENSE_FILE to this path name to run the
ILOG Views applications:

(cshitcsh):
% setenv ILOG_LICENSE_FILE SILVHOME/access.ilm
(sh/bash):

$ ILOG_LICENSE_FILE=$ILVHOME/access.ilm
$ export ILOG_LICENSE_FILE

(Windows 95/98/M e/ Windows NT/2000/XP):

C:\> set ILOG_LICENSE_FILE=%ILVHOME%\access.ilm

Various Versions
The libraries are stored in subdirectories of the directory 1ib/<system> on Unix and
lib\<system> on Windows (95/98/Me, and NT/2000/XP).
There are severd library files (static and shared equivalent):
Unix platforms:
¢ libxviews: Pure Xlib code of ILOG Views.
& libmviews: Motif-dependent code of ILOG Views.
Windows 95/98/Me, and NT/2000/XP platforms:
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Various Versions

winviews.1ib: Windows-dependent code of ILOG Views.

For al platforms (the name should be prefixed with 1ib on Unix platforms, and have the
. 1ib extension on Windows platforms):

.

Foundation Package
e ilog: ILOG utility classes (arrays, lists, and so on).
e views: Corelibrary. Includes Standard 2D graphics.

e ilvgadgt: Core Gadgetslibrary.

Thislibrary is provided with the Foundation Package, but can be used and deployed
only if you have the "ILOG Views' or "ILOG Views Controls" license. Thislibrary
contains the following classes: T1vMessageLabel, I1vFrame, I1vButton,
IlvToggle, IlvColoredToggle, I1lvComboBox, I1vTextField
IlvNumberField, IlvPasswordField, I1lvPopupMenu, I1vToolBar
IlvMenuBar, I1vScrollBar, IlvSlider, I1lvGadgetItem, I1vMenultem,
IlvGadgetContainer, IlvScrolledView, IlvDialog, I1lvIMessageDialog,
IlvIiInformationDialog, IlvIErrorDialog, IlvIWarner,
IlvIQuestionDialog, IlvGadgetContainerRectangle,
IlvSCGadgetContainerRectangle, I1lvSCViewRectangle.

e ilvmlook: Motif Look and Feel library.

e ilvwlook: Windows 3.11 Look and Feel library.
e ilvw95look: Windows 95 Look and Fedl library.
e ilvwxplook: Windows XP Look and Fedl library (Windows only).
e ilvprint: Printing support library.

e ilvbmpflt: Bitmap Filterslibrary.

e ilvbmp: BMP bitmap streamer.

e ilvwbmp: WBMP bitmap streamer.

e ilvpng: PNG bitmap streamer.

e ilvipg: JPG bitmap streamer.

e ilvppm: PBM-PPM bitmap streamer.

e ilvtiff: TIFF bitmap streamer.

e ilvrgb: SGI RGB bitmap streamer.

e iljs!ILOG Script library.

e ilvijs: ILOG Views Script implementation.

e iljsgide: ILOG Script debugger interface.
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ilvbuild: Resource-handling classes for binaries.

& Gadgets Package (Controls)

ilvadvgdt: Advanced Gadgets library (IlvMatrix, IlvTreeGadget, ...).
ilvadvgadmgr: Manager classes using advanced gadgets.

ilvatext: llIVAnnotext and related classes.

ilvedit: Inspector classes (Color chooser, Font chooser, ...).

ilvstates: Stateslibrary.

ilvamlook: Advanced Motif Look and Fed library.

ilvawlook: Advanced Windows 3.11 Look and Fedl library.

ilvaw951ook: Advanced Windows 95 Look and Feel library.

ilvawxplook: Advanced Windows XP Look and Feel library (Windows only).

ilvprtdlg: Printing dialogslibrary.

& Application Framework Package (Controls)

ilvappframe: Application Framework library.

ilvappmgr: Application Framework classes using the Manager package
(11vDvManagerDocument and related classes).

ilvappgrapher: Application Framework classes using the Grapher package
(11vDvGrapherDocument and related classes).

ilvappwizard: Application Framework library for wizard.

& Manager Package (2D Standard)

ilvmgr: Manager library (11vManager and related classes).

ilvgadmgr: Manager classes using gadgets (I1vGadgetManager and related
classes).

ilvmgrprint: Manager Printing support library.

& Data Access Add-On

dataccess: Core Data Access libraries (was'inform' in ILOG InForm 3.0).
dbaccess: Relational databases libraries (was'dbinform' in ILOG InForm 3.0).
dbchart: Charts-based Data Access classes library.

dbgadget: Gadgets-based Data Access classes library.

dbgantt: Gantt Chart-based Data Access classes library.
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Using Shared Libraries

e dbgraphe: Grapher-based Data Access classes library.

e dbsglgad: Relational Databases Gadgets classes library.
& Grapher Package (Advanced 2D)

e ilvgrapher: Grapher library (11vGrapher and related classes).

e ilvgadgraph: Grapher classes using gadgets (11vsCGrapherRectangle).
& Prototypes Package (Advanced 2D)

e ilvproto: Prototypes Baselibrary.

e ilvgdpro: Prototype classes using gadgets.
& Web Deployment Package (Advanced 2D)

e ilvweb: Web Deployment library.
¢ Charts Add-On

e ilvcharts: Chartslibrary (11vChartGraphic and related classes).
¢ Graph Layout Add-On

e ilvlayout: Core Graph Layout library.

e ilvbus: Buslayout library.

e ilvhierarchical: Hierarchical layout library.

e ilvorthlink: Orthogonal Link layout.

e ilvrandom: Random layout library.

e ilvtree: Treelayout library.
¢ Gantt Add-On

e ilvgantt: Gantt Chart library (I11vGanttChart and related classes).
& MapsAdd-On

e ilvmaps: Core Mapslibrary.

e ilvdbmaps: Database-based mapslibrary.

Using Shared Libraries

ILOG Viewslibraries are provided in both static and shared mode on all platforms (please
see the next section for Unix Users and Motif-based libraries).
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If you use shared libraries on a Unix platform, make sure the dynamic loader can find the
ILOG Viewslibraries. You do that by setting the environment variable LD_LIBRARY_PATH
(or suLIB_PATH on HP platforms or LTBPATH on ATX platforms) to $ILVHOME/1ib/
<system>/<shareDir>.

If you use shared libraries on a Windows platform, make sure that the system will actually
access the ILOG Views DLLs. Check the system documentation for more information.

Note for Unix Users

On Unix platforms, when you plan to link your application with ILOG Views, you have to
decide whether or not it will include pure Motif code. If thisis the case, then you need to
link with 1ibmviews.

If you need your application to be a pure Xlib application, then you need to link with

libxviews.

Never link with both, and aways link with one of these two. The library "views" islikely to
be necessary for every application.

Important Note About Motif and Shared Libraries
The use of 1ibmviews (Motif based) is deprecated in shared library format.

Since version 4.0, al shared libraries provided by ILOG Views are built using 1ibxviews
and areincompatible with 1ibmviews. 1ibmviews iSonly provided as astatic library and
can only be used with the static version of other ILOG Views libraries.

Note for Windows 95/98/Me, and NT/2000/XP Users

32

The libraries are provided in several versions on the Windows versions that are provided in
subdirectories of 1ib\<system>. Thisis dueto different versions of the run-time system
libraries and to the DLL. Each version needs specific compiler flags as described below:

€ msvc7 and x86_ .net2003_7.1:

e stat_sta: Staticlibrary in single thread with static run-time library using new
IOStreams. Flags. /GX /GR /ML /DIL_STD (Single Threaded).

e stat_mta: Staticlibrary in multithread with static run-time library using new
|OStreams. Flags: /Gx /GR /MT /DIL_STD (Multithreaded).

e stat_mda: Static library in multithread with dynamic run-time library using new
|OStreams. Flags: /Gx /GR /MD /DIL_STD (Multithreaded DLL).
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Note for Microsoft Visual C++ Users

e dl1_mda: Dynamic library in multithread with dynamic run-time library using new
|OStreams. Flags: /Gx /GR /MD /DIL_STD /DILVDLL (Multithreaded DLL).

Notes:

1. You must also use the flag /pILIsTDH if you want to use ILOG Script in these modes.
2. You must also link with the system librarieswsock32.1ib and imm32.1ib.

Known Problems with Windows 95

The following problems may occur in certain configurations of Windows 95:

4

Some top windows may |eave traces around themselves when they become hidden. This
problem seems to arise from some video driver configurations (see, in the Windows 95
online documentation, the notes about KB Windows 95, "ATI Mach 64 Display Adapter
Produces Garbled Screen," PSS-1D Q134487, 21 Aug 1995).

A possible workaround to avoid this problem is:

Select "System” from the " Setting" menu. The "System Properties' configuration panel
appears.

Choose the "Performance" Tab.
Click the "Graphics..." button. The "Advanced Graphics Settings' panel appears.

Move the "Hardware Acceleration” dlider to alower value. This slider indicates the
performance level of the video driver, from None to Full.

Programs seem to be locked when they try to read a CD-ROM drive that has no CD
inside. The system should display amodal error box, as on other Windows platforms, but
it does not (even though it waits for an answer). The workaround isto put aCD in the
drive, even after the system is locked.

Programs built with Borland C++ may crash when Windows Plusisinstaled (itis
pointed out in the Borland 5.0 installation notice). It seems to occur during the use of
iostream and floating point operations. Deactivate the Windows Plus Agent to run ILOG
Views applications, or get the patches for Windows Plus from the Microsoft Network, or
on the Microsoft anonymous server (ftp.microsoft.com), in softlib/mslfiles,
get thefile called plusupdl . exe.

Note for Microsoft Visual C++ Users

For al your projects, make surethat wsock32.1ib and imm32 . 1ib are specified in the link
command line.
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To debug your program more easily, add the following lines to the section [AutoExpand]
of thefile

msvc7 or x86_.net2003_7.1:
$INSTALLDIR%\Common7\Packages\Debugger\autoexp.dat

; from Ilog Views

IlvRect =x = <_orig._x,d> y = <_orig._y,d> width = <_w,u> height = <_h,u>
IlvPoint =x = <_x,d> y = <_y,d>

IlvTransformer =x11 = <_x11,g> x12 = <_x12,9> x21 = <_x21,g> x22 = <_x22,g> x0
= < _x0,g> y0 = <_vy0,9>

These lineslet you display the values of the objects that these classes define (instead of their
address) in the tooltip that appears when the mouse is positioned over a variable.

You may get a series of link errors when using the Visual C++ 6.0 integrated devel opment
environments to build your project in Debug mode.

In Debug mode, to be able to link your application with Visual C++ and the libraries
provided in ILOG Views, follow these instructions:

msvc7 or x86_.net2003_7.1:

e inMicrosoft Visual Studio.NET, select your projectsin the " Solution Explorer”
window,

o right-click on the selection and choose the "Properties’ item,

e inthe"Property Pages' window, select "Configuration Properties” -> "C/C++" ->
"Preprocessor”,

e inthe"Preprocessor Definitions' field, remove” DEBUG",

e recompile and relink the application.
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Release Notes for Version 5.0.1

These rel ease notes describe the changes that have been made to ILOG Views since version
5.0. This document describes:

& Changes Snce \ersion 5.0
& Corrected Patches Since Version 5.0

Changes Since Version 5.0

Note: All known incompatibilities in this version of ILOG Views compared to previous
versions are described in the file compaT . TxT located at the same location as the product
README files.

Please read it if you have any problems compiling or running your oldapplications.

If you have problems using the ILOG Miews libraries, and if the documentation does not
help you fix your problem, please send a bug report to the ILOG support team, using the
template provided in the file BUGREPORT, Or bugreprt . txt if you are using a Windows
platform.
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Compilation issues

ILOG Viewsis delivered with aset of libraries that are stored in a directory that depends on
the type of machine you are using, the operating system it runs on, and the compiler you
plan to use. This directory can be one of the following:

alpha_4_6.1 Machine: Compaqg (DEC) Alpha
os: OSF1 V4 or higher
Compiler: C++ 6.1 or higher

hp32_11_3.05 Machine: HP 9700
os: HP-UX 11 or higher
Compiler: HP C++ A.03.05 or higher

hp32_11_3.30 Machine: HP 9700
OsS: HP-UX 11 or higher

Compiler: HP C++ A.03.30 or higher using -mt -AA
options

hp64_11_3.15 Machine: HP 9700
Os: HP-UX 11 or higher

Compiler: HP C++ A.03.15 or higher in 64 bit mode
(+DA2.0W)

hp32_11_3.39 M i86_linux2_glibc2.2_gcc3.0: Machine: PC
Os: Linux 2.4 or higher (glibc 2.2)
Compiler: gcc3.0.2

i86_linux2_glibc2.3_gcc3.2 Machine: PC
Os: Linux 2.4 or higher (glibc 2.3)
Compiler: gcc3.2

msvcé Machine: PC

os: Windows 95/98/Me or
Windows NT/2000/XP

Compiler: Microsoft Visual C++ 6.x

msvc7 Machine: PC

os: Windows 95/98/Me or
Windows NT/2000/XP

Compiler: Microsoft Visual C++ 7.0
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Changes Since Version 5.0

x86_.net2003_7.1

Machine: PC

os: Windows 95/98/Me or

Windows NT/2000/XP

Compiler: Microsoft Visual C++ .NET 2003

rs6000_4.3 3.6

Machine: RS6000
OsS: AIX 4.3.2 or higher
Compiler: CSet++ (3.6 or higher) or Visual Age 5.0

rs6000_5.1_6.0

Machine: RS6000
Os: AIX 5.1 or higher

Compiler: Visual Age 6.0 (using standard C++ streams
(-DIL_STD)

sparc_5 5.0

machine: Sun Sparc Station
os: Solaris 2.4 or higher

Compiler: Sun C++ 5.0 (Patch 1
M07311-05 or higher)

ultrasparc64_5 5.0

Machine: Sun Ultra Sparc Station
os: Solaris 2.7 or higher
Compiler: Sun C++ 5.0 (Patch 107311-05) or higher

The operating system will be referred to as <system> in the following text.

You may need to change the provided makefiles to match your specific installation

requirements:

¢ VIEWSDIR must be set to the di
ilog/viewsxx onuUnix or c:\
current version of ILOG Views);

¢ XINCand XLIBS should be set

rectory where you unpacked the product (usually /usr/
ilog\viewsxx on Windows, where XX indicates the

to the directory where your X11 include and lib

directories are located (only on Unix platforms)

¢ MINC and MLIBS should be set to the directory where your Motif include and lib
directories are located (only on Unix platforms);
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Platforms no longer supported
The following table lists the platforms that are no longer supported:

hp_10_1.0: HP-UX 10, HP aC++

Replaced by hp32_11_3.05 or hp32_11_3.30,
requiring HP-UX 11.

i86_linux2_glibc2.1_egcsl.1 Linux 2.0, Egcs 1.1.

Replaced by i86_linux2_glibc2.2_gcc3.0
sgi32_6.5_7.2 IRIX platforms are no longer supported.
sparc_5 4.0 Solaris 2.4, Sun C++ 4.0.

Replaced by sparc_5_ 5.0 or ultrasparc64_5_5.0, requir-
ing Sun C++ 5.0 (or higher)

rs6000 AlX 3.2, CSet++ 2.1.

Replaced by rs6000_4.3_3.6, requiring AIX 4.3 or
higher

Execution Requirements

To ensure that every binary provided works properly, you need to set the environment
variable ILVHOME to the directory where the product has been installed. Usually, you will
Set:
(csh/tcsh) :
% setenv ILVHOME /usr/ilog/viewsXX
(sh/bash) :
$ ILVHOME=/usr/ilog/viewsXX
$ export ILVHOME
(Windows 95/98/Me / Windows NT/2000/XP) :
C:\> set ILVHOME=C:\ILOG\VIEWSXX
Check with your system administrator the exact product installation directory.

Library build information (Unix platforms only)

If aproblem occurs while running your applications, you can retrieve the information on the
platform that has been used to build the library, using the shell script called ilvversion.sh,
located in the ILOG Views root directory.

Go into the specific static subplatform subdirectory of 'lib’, and type:

./../../ilvversion.sh

Two lines that have the following form will be printed out (these lines may be swapped):
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IlvVersion: X.X

IlvBuild: OS - platform - compiler - display revision

The shell script just locates the strings T1vBuild andIlvversion inthelibrary file
libxviews.a, and printsout the result.

If you have installed multiple platformsin the directory ILVHOME, you can check each of
the platforms:

S cd S$ILVHOME

$ ./ilvversion.sh platform

whereplatform isthe system identifier of the ILOG Viewslibrary (that is, the <system>,
one of hp32_11 3.30, rs6000_4.3 3.6, sparc 5 5.0...).

Changes in ILOG Views Studio

A ready-to-use version of ILOG Views Studio, delivered asabinary file called
"ivEstudio" isprovidedinthe studio/<system> directory.

ILOG Views Studio isa GUI builder that will help you create and generate ILOG Views
applications.

Directories

& data/ilviews: Containsthe datafiles used by the library (inspector panels, message
databases, and so on).

data/images: Containsimage datafiles.
data/icon: Contains someicons.

data/Dcw: Contains some DCW-generated files.

* 6 o o

bin: Contains binary files, along with source code.
The README filein the bin directory explains how to build these binary files.
Two useful programs can be built in <ILVHOME>/bin/<system>:

e ilv2data, which can build a"resourcefile" that can be linked with your application
in order to make it environment-independent.

e splitdbm, which converts pre-3.0 message databases into the new format, including
the new language definition, and encoding.

¢ samples: contains samplefiles.

For each sample, you need to go to the platform directory and run the make utility to
build it.

® tools: contains more specific solutions to common problems.
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Licensing

If you have afile called $ILVHOME/access.ilm on Unix or %ILVHOM E%\access.ilm on
Windows, then thisis an evaluation copy of ILOG Views.

You must set the environment variable ILOG_LICENSE_FILE to this path name to run the
ILOG Views applications.

(csh/tcsh) :

% setenv ILOG_LICENSE_FILE SILVHOME/access.ilm
(sh/bash) :

$ ILOG_LICENSE_FILE=$ILVHOME/access.ilm

$ export ILOG_LICENSE_FILE
(Windows 95/98/Me / Windows NT/2000/XP) :

C:\> set ILOG_LICENSE_FILE=%ILVHOME%\access.ilm

Various Versions

The libraries are stored in subdirectories of the directory 1ib/<system> on Unix and
lib\<system> on Windows (95/98/Me, and NT/2000/XP).

There are several library files (static and shared equivalent):
¢ Unix platforms:
libxviews: Pure Xlib code of ILOG Views.
libmviews: Motif-dependent code of ILOG Views.
& Windows 95/98/Me, and NT/2000/XP platforms:

winviews.1lib: Windows-dependent code of ILOG Views.

For al platforms (the name should be prefixed with 'lib" on Unix platforms, and have the
1ib extension on Windows platforms):

Library Name Description

ilog: ILOG utility classes (arrays, lists...)

ILOG utilitity classes ilvmlook: ilvwlook: ilvw95look: ilvwxplook:
(arrays, lists...)

Gadgets package
(Controls)

Application Framework
package (Controls)
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Library Name

Description

Manager Package (2D
Standard)

Grapher Package
(Advanced 2D)

Prototypes Package
(Advanced 2D)

Web Deployment package
(Advanced 2D)

Data Access add-on

Charts add-on

Charts library (I1vChartGraphic and related classes)

Graph Layout add-on

Gantt add-on

ilvGantt: Gantt Chart library (I1vGanttChart and related classes)

Maps add-on

Using Shared Libraries

ILOG Views libraries are provided in both static and shared mode on all platforms (please
see the next section for Unix Users and Motif-based libraries).

If you use shared libraries on a Unix platform, make sure the dynamic loader can find the
ILOG Viewslibraries. You do that by setting the environment variable

LD _LIBRARY_PATH (or SHLIB_PATH on HP platforms or LIBPATH on AlX platforms)
10 $ILVHOME/lib/<system>/<shareDir>.

If you use shared libraries on a Windows platform, make sure that the system will actually
access the ILOG Views DLLs. Check the system documentation for more information

Note for Unix Users

On Unix platforms, when you plan to link your application withILOG Views, you have to
decide whether or not it will include pure Motif code. If thisisthe case, you need to link
with libmviews. If you need your application to be a pure Xlib application, you need to link
with libxviews. Never link with both, and always link with one of these two. Thelibrary
"views' islikely to be necessary for every application.

Important Note about Motif and Shared Libraries
The use of libmviews (Motif based) is deprecated in shared library format.
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Since version 4.0, al shared libraries provided by ILOG Views are built using 1ibxviews
and areincompatible with 1ibmviews. 1ibmviews iSonly provided as astatic library and
can only be used with the static version of other ILOG Views libraries.

Note for Windows 95/98/Me, and NT/2000/XP Users

Thelibraries are provided in severa versions on the Windows versions that are provided in
subdirectories of 1ib\<system>. Thisis dueto different versions of the run-time system
libraries and to the DLL.

Each version needs specific compiler flags, as described below:
€ msvcb & msve7 & x86_.net2003_7.1:

e Stat_sta: Static library in single thread with static run-time library using new
|OStreams.

Flags. /GX /GR /ML /DIL_STD (Single Threaded).

o Stat mta Static library in multithread with static run-time library using new
|OStreams.

Flags. /IGX /GR /MT /DIL_STD (Multithreaded).

o stat_mda Static library in multithread with dynamic run-timelibrary using new
|OStreams.

Flags: /GX /GR /MD /DIL_STD (Multithreaded DLL).

e dll_mda: Dynamic library in multithread with dynamic run-time library using new
|OStreams.

Flags: /GX /GR /MD /DIL_STD /DILVDLL (Multithreaded DLL).
You must also use the flag /DILJSTDH if you want to use ILOG Script in these
modes.

l Note:

& msvco only:
e Stat_st: Static library in single thread with static run-time library.
Flags: /ML (Single Threaded).
e Stat_mt: Static library in multithread with static run-time library.
Flags: IMT (Multithreaded).

o stat_md: Static library in multithread with dynamic run-time library.
Flags: IMD (Multithreaded DLL).

e dil_md: Dynamic library in multithread with dynamic run-time library.
Flags: /MD /DILVDLL (Multithreaded DLL).
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You must also use the flag /DILJSTDH if you want to use ILOG Script in these
modes.

l Note: You must also link with the system librarieswsock32.1ib and imm32.1ib

Known problems with Windows 95
The following problems may occur in certain configurations of Windows 95:

Some top windows may |eave traces around themsel ves when they become hidden. This
problem seems to arise from some video driver configurations (see, in the Windows 95
online documentation, the notes about KB Windows 95, "ATIl Mach 64 Display Adapter
Produces Garbled Screen,” PSS-1D Q134487, 21 Aug 1995).

A possible workaround to avoid this problem isto do the following:

1. Select "System" from the "Setting” menu. The "System Properties’ configuration panel
appesrs.

2. Choose the "Performance" Tab.
3. Click the "Graphics..." button. The "Advanced Graphics Settings' panel appears.

4. Movethe "Hardware Acceleration” slider to alower value. This dlider indicates the
performance level of the video driver, from None to Full.

Programs seem to be locked when they try to read a CD-ROM drive that has no CD inside.
The system should display amodal error box, as on other Windows platforms, but it does not
(even though it waits for an answer). The workaround isto put a CD in the drive, even after
the system is locked.

Note for Microsoft Visual C++ users

& For al your projects, make sure that wsock32.lib and imm32.lib are specified in the link
command line.

& To debug your program more easily, add the following lines to the section [ AutoExpand]
of thefile:

For msvce:
For msvec7 or x86_ .net2003_7.1:

Theselines et you visualize the val ues of the objects that these classes define (instead of
their address) in the tooltip that appears when the mouse is positioned over a variable.

You may get a series of link errors when using the Visual C++ 6.0 integrated devel opment
environments to build your project in Debug mode.
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In Debug mode, to be able to link your application with Visual C++ and the libraries
provided in ILOG Views, follow these instructions:

¢ Onmsvce:
1. In Developer Studio, choose the menu option "Project” -> " Settings...".
. Make sure you select all your Debug projects in the "Settings for..." panel.
. Select the "C/C++" notebook tab.
. Inthis page, select the "Preprocessor” option of the "Category" option menu.

2
3
4
5. Inthe "Preprocessor definitions:" entry field, remove"_DEBUG".
6. Recompile and relink the application.

L 2

Onmsve7 Or x86_.net2003_7.1:

=

In Microsoft Visual Studio.NET, select your projectsin the Solution Explorer window
Right-click on the selection and choose the Properties item
In the Property Pages window, select Configuration Properties -> C/C++ -> Preprocessor

In the Preprocessor Definitions field, remove _DEBUG

o > w DN

Recompile and relink the application.
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Corrected Patches Since Version 5.0

PATCH 50.0001
Description: Views 4.02 forces the use of buffered drawing operations on gadget containers.

Libraries. views, ilvgadgt, ilvmgr
Packages. foundation, manager

PATCH 50.0002

Description: Menu Items of combo boxes may stay on the screen when using the ‘fade item’
feature of Windows.

Libraries. ilvgadgt
Packages. foundation

PATCH 50.0003

Description: On X11, TlvabstractView: :setSensitive doesn't propagateto its
children views.

Libraries. xviews
Packages: foundation

PATCH 50.0004

Description: [didlogs] I1vFileBrowser: :setFileName iSNo longer taken into account
since patch 40.2045

Libraries. winviews
Packages: foundation

PATCH 50.0005
Description: Error with serialization of boolean values.

Libraries:. ilvcharts, ilvgantt, ilvgrapher, ilvproto, ilvweb, views
Packages: charts, gantt, grapher, protos, web, foundation

PATCH 50.0006
Description: Last page may be previewed severa times.

Libraries. ilvprint
Packages. foundation

PATCH 50.0007
Description: [layout] quadtree errorswhen using 11vBus Layout: :setBus Mmethod.

[layout] no pragma which force the library link on PC
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Libraries. ilvbus
Other files:

include/ilviews/layout/macros.h, include/ilviews/layout/bus.h,
include/ilviews/layout/hierarchical.h, include/ilviews/layout/
orthlink.h, include/ilviews/layout/random.h, include/ilviews/
layout/tree.h

Packages. layout, appframe

PATCH 50.0008
Description: stretchBitmapData does not work in 8 hits.

Libraries. xviews,mviews, winviews
Packages. foundation

PATCH 50.0009
Description: T1vFilterFlow triesto load an empty filter using modules.

Libraries. xviews, mviews, winviews
Packages. foundation

PATCH 50.0010
Description: IlvIndexedBitmapData doesnot handle rectangular copy.

Libraries: xviews,mviews, winviews
Packages: foundation

PATCH 50.0011

Description: The tiff streamer cannot save tiled indexed bitmap datas Read/Write callbacks
are not always called in the Tiff streamer. Tiff streamer does not handle correctly border
tiles.

Libraries: ilvtiff
Packages: foundation

PATCH 50.0012
Description: The Data Access application crashes at exit.

Libraries. dataccess
Packages. dataccess

PATCH 50.0013
Description: It isimpossible to hide the scrollbarsin an 11ipbStringList.

Libraries. dbgadget

Packages. dataccess
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PATCH 50.0014
Description: [appframe] no pragmawhich force the library link on PC.

[appframe] Some .h filesin the distrib cannot be parsed with the samples/appframe/synedit
example.

[Appframe] The document save modifications dialog box is not triggered under UNIX under
specific circumstances

Libraries. ilvappframe

Other files. samples/appframe/synedit/src/synparse.cpp, include/
ilviews/appframe/macros.h, include/ilviews/appframe/manager/
macros.h, include/ilviews/appframe/grapher/macros.h, include/
ilviews/appframe/wizard/macros.h

Packages. appframe

PATCH 50.0015

Description: [studio] The registered include files and libraries are not always properly taken
into account during code generation.

Libraries. ivstudio
Packages. foundation

PATCH 50.0016

Description: studio.appli doesn't register the i 1vproto dependancies. There are
missing dependencies for prototype library

Libraries. ivstudio
Packages: foundation

PATCH 50.0017
Description: T1voutlinePolygon border isbadly drawn with alarge thickness

Libraries: winviews, views
Packages:  foundation

PATCH 50.0018
Description: T1varc:: contains may return wrong results under extreme conditions

Libraries. display
Packages. foundation

PATCH 50.0019

Description: [manager] : cannot undo/redo I1vManagerMakeListLabelInteractor
object creations

Libraries. ilvmgr, ilvgadmgr, ilvadvgadmgr
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Packages. manager, gadgets

PATCH 50.0020
Description: The 11vParser class doesn't deleteits variables.

Libraries: ilvvar31l
Packages. compat

PATCH 50.0021

Description: The old charts code was not updated after the studio code generation was
modified in Views5.0

Libraries:. views31,ilvstoldcharts31l
Packages. compat

PATCH 50.0022

Description: When Caps Lock is on on Windows, pressing a key + shift yields an event
where _modifiersis 11vshiftModifier instead of O

Libraries. winviews
Packages: foundation

PATCH 50.0023
Description: I1iDbTreeGadget iStoo slow when you have alot of items

Libraries:. dbgadget
Packages. dataccess

PATCH 50.0024
Description: Studio crash at exit

Libraries: ivstudio
Packages. foundation
PATCH 50.0025

Description: Small defects with the dialog used to select the size of the printing in ivfstudio.

Libraries: ivstudio
Packages. foundation

PATCH 50.0026

Description: [studio] The callbackslist in graphics inspector are not notified of the
interactor changes.

Libraries. ivstudio

Packages. foundation
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PATCH 50.0027

Description: [appframe] Closing one of the containers opened on the document will trigger
the prompt for saving the document.

Libraries. ilvappframe
Packages. appframe

PATCH 50.0028
Description: zoomable label potentially corrupts the world transformation on NT platforms

Libraries. winviews
Packages. foundation

PATCH 50.0030
Description: Bad management of submenus with Windows Multiple Monitors feature

Libraries. ilvgadgt, ilvwlook, ilvw95look
Packages: foundation

PATCH 50.0031
Description: bad update of the attachments when a panel is resized at init time

[foundation] attached graphics may be badly resized when setting a guide limit.
Libraries. views
Packages: foundation

PATCH 50.0032

Description: Crash after embedding a menu in a graphic handle. A tear off popup menu
closes automatically after selection

Libraries. ilvgadgt, ilvmgr
Packages. foundation, manager

PATCH 50.0033

Description: IFC: XML bad encoding check for UTF-16 without signature and Wrong
endian UTF-16 without signature.

Libraries. ilog
Packages. foundation

PATCH 50.0034
Description: Palette clip conflict when previewing before printing.

Libraries. ilvprint

Packages. foundation
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PATCH 50.0035
Description: [Studio][Protos] Invisible graphics of the proto are made visible on edition

[protos] prstudio crashes when saving an .ilv file that contains a prototype that was
previously removed from its library

Libraries:
Packages. protos

PATCH 50.0036
Description: [prstudio] crash when removing the name of a protoinstance

[protos] cannot set a name to a protographic copy under ivfstudio
Libraries. ilvproto
Packages. protos

PATCH 50.0037
Description: [protos][studio] save proto library as crashes

Libraries:. prstudio
Packages: protos

PATCH 50.0038
Description: [Protos] 3.1 to 4.0 incompatibility: inherited values are hardcoded in 4.0
proto's description.

Libraries:. ilvproto
Packages: protos

PATCH 50.0039

Description: IlvContainerGraphicHolder: :setPropertyToGraphic leadsto afree
memory read.

Libraries. views, ilvadvgdt, ilvmgr
Packages. foundation, gadgets, manager

PATCH 50.0040
Description: PrStudio: cannot select an attribute name in an attribute parameter field.

Libraries. prstudio
Packages. protos

PATCH 50.0041
Description: Cannot close the combo box menu using the Escape key.

Libraries. ilvgadgt
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Packages. foundation

PATCH 50.0042

Description: A pair of notify/watch accessor might not work as expected if the attribute
attached to the watch accessor is untyped.

Libraries. views
Packages. foundation

PATCH 50.0043
Description: [Studio]ln some circumstance the apply button does not work fine.

Libraries: ivstudio
Packages. foundation

PATCH 50.0044
Description: [windows] llvWindowsDevice printing is affected by small/large fonts display
Settings.

Libraries. winviews
Packages: foundation

PATCH 50.0045
Description: [printing] studio crashes when setting a dummy preview page.

[printing] missing localized printing.dbm file in the distribution.
Libraries: ilvprtdlg

Other files: data/res/printing.rc, data/printing/locale/fr_FR.windows-1252/printing.dom,
data/printing/local e/fr_FR.I SO-8859-1/printing.dom

Packages. gadgets, foundation

PATCH 50.0046

Description: [appframe] Alt Keyboard accelerator key is mapped to the I11valtModifier
(should be llvMetaM odifier).

Libraries. ilvappframe
Packages. appframe

PATCH 50.0047

Description: On Windows, it is not possibleto return to English locale if ivfstudio is
started in Japanese or Chinese.

Libraries:

Other files: bin/res/i2dblock.rc, data/res/winviews.rc, dataliljscript/locale/fr_FR.windows-
1252/gide.dom, data/iljscript/locae/fr_FR.windows-1252/messages.js, studio/data/res/
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foundation.rc, studio/data/res/script.rc, studio/msvc6/ivfstudio.exe, studio/msvc7/
ivfstudio.exe

Packages. foundation

PATCH 50.0048

Description: On Windows, it is not possibleto return to English locale if ivfstudio is
started in Japanese or Chinese.

Libraries:
Other files: data/res/appframe.rc
Packages. appframe

PATCH 50.0049

Description: On Windows, it is not possibleto return to English locale if ivfstudio is
started in Japanese or Chinese.

Libraries:
Other files: studio/data/res/gadgets.rc
Packages. gadgets

PATCH 50.0050
Description: [Windows] The printing of opague bitmapsis black.

Libraries. winviews
Packages: foundation

PATCH 50.0051

Description: Problem with same messages defined in several dbm files with different
languages.

Libraries: display
Packages: foundation

PATCH 50.0052

Description: T1vMatrix doesnot show itstooltip after having shown an
IlvGraphicMatrixItem tooltip.

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0053
Description: Crash when trying to export a table schemafrom ivfstudio.

Libraries. dbstsqgl

Packages. dataccess
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PATCH 50.0054
Description: T1vbisplay::colorTable doesn't properly handle mutable colors.

Libraries. display
Packages. foundation

PATCH 50.0055
Description: Keyboard shortcuts are not invoked with minimized MDI views.

Libraries. views, ilvgadmgr, ilvadvgdt
Packages. foundation, manager, gadgets

PATCH 50.0056

Description: The 11vDisplayTestapi notification mechanismsworks partialy on
Windows.

Libraries. winviews
Packages: foundation

PATCH 50.0058
Description: Tooltips might not work on atransient view with no border (on Windows).

Libraries: winviews, views, ilvgadgt
Packages: foundation

PATCH 50.0060
Description: [studio][printing] Japanese locale causes ivEstudio to crash at print preview.

Libraries. ilvprint
Packages. foundation

PATCH 50.0061
Description: The 11iTableComboBox does not support the multi-display.

Libraries. dbgadget
Packages. dataccess

PATCH 50.0062
Description: [Windows] Labels are not displayed with correct font.

Libraries. winviews
Packages. foundation

PATCH 50.0063
Description: Bad management of keyboard eventsin 11vviewFrame since Patch 50.00055

Libraries: ilvadvgdt
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Packages. gadgets

PATCH 50.0064
Description: Bad drawing of a nhotebook in Windows XP Look.

Libraries. ilvawxplook

Packages. gadgets

PATCH 50.0065

Description: ivfstudio may crash when creating and IIvFilteredGraphic on UNIX 8 hits
display

Libraries. views

Packages. foundation

PATCH 50.0066

Description: [IFC-WINDOWS]Test of write access on pathname with a blank always
reflurns I1rFalse.

Libraries: ilog
Packages: foundation

PATCH 50.0067
Description: Several problems on Dockable Windows

Libraries: winviews, ilvadvgdt
Packages:  foundation, gadgets

PATCH 50.0068
Description: Cannot trace the memory manager

Libraries. ilog
Packages. foundation

PATCH 50.0069

Description: T1vDisplay: :putBitmapData may not work on Windows after some
drawings have been made in the bitmap.

Libraries. winviews
Packages. foundation

PATCH 50.0070
Description: fr_FR.windows-1252/dvwizard.dbm file uses an incorrect encoding.

[appframe][dvwizard] The docking position of viewsis not taken into account.

[appframe] There are inconsistencies in the modality/transience of some dialog boxes.
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Libraries. ilvappframe

Other files: bin/data/appframe/dvwizard/locale/fr_FR.windows-1252/dvwizard.dbm, bin/
data/appframe/dvwizard/locale/fr_FR.1 SO-8859-1/dvwizard.dbm

Packages. appframe

PATCH 50.0071
Description: Bitmap streamers are not correctly registered.

Libraries. xviews, mviews, winviews
Packages. foundation

PATCH 50.0072

Description: TlviWindowsDevice: :setOrientation () hasno effect, only the printer
default configuration is used.

Libraries. winviews
Packages. foundation

PATCH 50.0073

Description: [DvWizard][AppFrame] Deleting the "RecentProjects’ command crashes the
wizard.

Libraries:. ilvappwizard
Packages: appframe

PATCH 50.0074
Description: T1vRGBBitmapData: :alphaCompose MMX codeis not optimal.

Libraries. winviews
Packages: foundation

PATCH 50.0075

Description: [Protos] 11vGroupInputFile badly reads double quoted values when the
decimal symbol is','.

Libraries. ilvproto
Packages. protos

PATCH 50.0076
Description: Bugin IlvText: :getSelectedText in amultibyte environment.

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0077
Description: The generated panel subclass constructor code (ivfstudio) isincorrect.
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Libraries. ilvstappli
Packages. gadgets

PATCH 50.0078

Description: T1vDisplay: :colorTable might be called on Windows (depth usually > 8)
after a4 or 8 bits deep bitmap has been read.

Libraries. xviews, mviews, winviews
Packages. foundation

PATCH 50.0079

Description: T1vMoveInteractor leavesaghost upon click on a button different from
IlvLeftButton.

Libraries. views
Packages. foundation

PATCH 50.0080
Description: [AppFrame] generated project application may crash on

IlvDvProjectDocument: :activateItem.
Libraries:. ilvappframe
Packages: appframe

PATCH 50.0081
Description: The drawing of 1-bit deep transparent bitmaps isincorrect after patch 402065.

Libraries. winviews
Packages: foundation

PATCH 50.0082

Description: 11vDisplay: :colorTable might be called on Windows (depth usually > 8)
when saving a4 or 8 bits deep bitmap.

Libraries. winviews
Packages. foundation

PATCH 50.0083

Description: Impossible to choose different initial docking configurations for each view of
an appframe document.

Libraries. ilvappframe

Packages. appframe
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PATCH 50.0084

Description: T1viWritePBMBitmap may try to access the display colorTable whilein
TrueColors.

Libraries. winviews, mviews, xviews
Packages. foundation

PATCH 50.0085

Description: Drawing abitmap is drawn with a palette that has an alpha value causes the
memory use to increase (dll).

Libraries. winviews, ilvgdiplus
Packages. foundation

PATCH 50.0086
Description: IlvMarkingMenu does not delete all the windows upon creation.

Libraries: ilvadvgdt
Packages: gadgets

PATCH 50.0087
Description: I1xmlParser doesnot parse correctly the <IDOCTYPE ... > tag

Libraries: ilog
Packages: foundation

PATCH 50.0088

Description: [studio] Two sucessive commeas are generated in the 'Panel Subclass
constructor.

Libraries. ilvstappli
Packages. gadgets

PATCH 50.0089

Description: [Event player] The player does not play correctly when we move the dider of
the scrollbar.

Libraries. xviews, winviews, mviews
Packages. foundation

PATCH 50.0090

Description: T1vSystemPort: :GetBitmapData May crash when dealing with a masked
bitmap.

Libraries. xviews, mviews, winviews

Packages. foundation
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PATCH 50.0091

Description: [AppFrame] Closing one of the two views associated to a document may not
close the document.

Libraries. ilvappframe
Packages. appframe

PATCH 50.0092
Description: Cannot save custom eventsin the event player.

Libraries. winviews, mviews, xviews
Packages. foundation

PATCH 50.0093
Description: [Windows] llvZoomableTransparentlcon cannot be rotated by 180 deg

I1lvZoomableIcon can't beflipped.

IlvTransformer: :isScale returnstrue for symmetries.
Libraries: display

Packages: foundation

PATCH 50.0094

Description: [appframe] The confirmsave diaog box is not transient wrt the main
window.

Libraries: ilvappframe
Packages: appframe

PATCH 50.0095

Description: Bad redraw when zooming in an areawith a scale using crossing values and
chart cursor.

Libraries. ilvcharts
Packages. charts

PATCH 50.0096

Description: The dockable pane initiates a dragging operation on a ButtonDown event
without checking which button is down.

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0097

Description: When replacing the whole text in a matrix cell, the first character may not be
visible.
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Libraries. ilvgadgt
Packages. foundation

PATCH 50.0098

Description: [AppFrame] duplicate resource are generated when two actions share the same
icon.

Libraries. ilvappframe
Packages. appframe

PATCH 50.0099

Description: [AppFrame] A crash may occur on UNIX when closing very fast frames from
the 'More Windows' panel.

[AppFrame] Closing one of the two views associated to a document may not close the
document.

Libraries. ilvappframe
Packages. appframe

PATCH 50.0100
Description: Deleting amenu item from the ivfstudio menu inspector turns theitem into a
separator.

Libraries: ilvstgadget
Packages: gadgets

PATCH 50.0101
Description: IliErrorMessage: :getMessage () returnsan empty string.

Libraries. dataccess
Packages. dataccess

PATCH 50.0102

Description: Values (2, 1) for the stepsCount/subStepsCount in the
IlvSingleScaleDisplayer causesacrash.

Libraries. ilvcharts
Packages. charts

PATCH 50.0103

Description: pviizard crashes when anew item isinserted in the menu bar of the
generated application.

DvWizard : When the document (or view) class changes, the "derived from" field isreset to
IlvDvDocument (OF I1vDvTextView)
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Libraries. ilvappwizard
Other files: bin/data/appframe/dvwizard/dvwizard.odv
Packages. appframe

PATCH 50.0104
Description: The code generation does not work for 11vChartGraphic .

Libraries. ilvcharts, ilvgadgraph
Packages.  charts, grapher

PATCH 50.0105
Description: Z Order of overlapping sibling windows is not portable across platforms

Libraries. winviews
Packages. foundation

PATCH 50.0106

Description: An IlvChartGraphic Withan I1vPieChartDisplayer read froman LV
file might not be updated properly when a point is added to one of its dataset.

Libraries. ilvcharts
Packages:  charts

PATCH 50.0107

Description: The header file of non I1vGadgetContainer base classesis not added to
generated code.

Libraries: views, ilvstappli
Packages:  foundation, gadgets

PATCH 50.0108
Description: [studio] [solaris] Delete key has no action when num lock is on.

Libraries: ivstudio
Packages. foundation

PATCH 50.0109

Description: [appframe] appframe prompts for document reloading everytimeit is
reactivated.

Libraries. ilvappframe
Packages. appframe

PATCH 50.0110

Description: TlvCircularScale: :draw usesaclip based on _drawrect instead of the
object's bounding box.
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Libraries. views
Packages. foundation

PATCH 50.0111

Description: Studio doesn't generate the #include <ilviews/graphics/sel ector.h> line when
an IlvSelector isused.

Libraries. views
Packages. foundation

PATCH 50.0112
Description: Call to varargs functions must have explicitly typed arguments (HP 64 bits).

Libraries. ilvappframe, ilvappwizard
Packages. appframe

PATCH 50.0113
Description: T1vTransformedGraphic: :applyTransform doesn't perform well on
every objects.

Libraries. views
Packages: foundation

PATCH 50.0114

Description: [gadgets] IlvMenultem accelerators should ignore some modifiers (ex:
numlock on solaris).

Libraries: ilvgadgt
Packages: foundation

PATCH 50.0115

Description: [Windows] T11vSystemPort: : fillPolyline May raise an error when
drawing only one point.

Libraries. winviews
Packages. foundation

PATCH 50.0116

Description: [Windows] it is not possible to print with the default printer without displaying
the print Dialog.

Libraries. winviews

Packages. foundation
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PATCH 50.0117

Description: [gadgets] T1vIFileSelector doesnot match the UNIX behavior regarding
relative paths.

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0118
Description: Problem with I11vPrintableComposite

Libraries. ilvprint
Packages. foundation

PATCH 50.0119
Description: Clicking onan 11isimpleToggle makes the application crash.

Libraries:. dbgadget
Packages. dataccess

PATCH 50.0120

Description: [studio] It is not possible to specify a baseclass without class information (no
header in the generated fil€).

Libraries: ilvstappli
Packages: gadgets

PATCH 50.0121

Description: T1vswitchAccessor uses"delete[]" to free memory allocated with new or
malloc (FMM).

Libraries. ilvproto
Packages. protos

PATCH 50.0122

Description: The "16 hits" clipping done by Views before calling X11 drawing primitiveis
not enough to prevent X Server drawing oddities

Libraries. xviews, mviews
Packages. foundation

PATCH 50.0123

Description: [gadgets] 11vNumberField may crash studio while reading back the min/max
data (precision issue).

Libraries. ilvgadgt

Packages. foundation
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PATCH 50.0124
Description: [charts] Removing an scale from an T1vChartGraphic causesacrash.

Libraries. ilvcharts
Packages. charts

PATCH 50.0125
Description: T1vReliefGauge doesn't register any "ClassCode" information.

Libraries. views
Packages. foundation

PATCH 50.0126

Description: T1vstringList scrollbars adjusting produces unmatched up and down
scrolls.

Libraries:. ilvadvgdt
Packages: gadgets

PATCH 50.0127
Description: Several sensitivity/focus problem on notebook and containers.

Libraries: ilvgadmgr, ilvgadgt
Packages: manager, foundation

PATCH 50.0128

Description: The"State" accessor in the "general” tab of the studio graphic inspector doesn't
work properly.

Libraries: ivstudio
Packages. foundation

PATCH 50.0129
Description: The generated code for Chart can crash when the format is static.

Libraries. ilvcharts
Packages. charts

PATCH 50.0130
Description: Theinclude for 11vChartLegend isnot generated by studio.

Libraries. ilvcharts
Packages. charts

PATCH 50.0131

Description: When alegend connected to a chart is removed from a studio buffer, the chart
keeps refering to the legend.
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Libraries. ilvstcharts
Packages. charts

PATCH 50.0132

Description: T1lvSpinBox: :setValue dOesreturn I1False ON SUCCESS Since patch
40.2020 (BR 2001.189).

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0133
Description: The contents of the manager may be printed on the footer and header.

Libraries. winviews
Packages. foundation

PATCH 50.0134
Description: Moving up and down datasets in chart inspector causes studio to crash.

Libraries. ivstudio
Packages: foundation

PATCH 50.0135

Description: The Studio T1vToggleFilteredGraphicCommand dOes not consider an
IlvGrapher buffer.

Libraries: ilvstgrapher
Packages:  grapher

PATCH 50.0136
Description: Studio messages editor crashes (I1vMessagePanel bug).

Libraries. ilvedit
Packages. gadgets

PATCH 50.0137

Description: [studio] Remove data from the dataset chart inspector does not refresh the
last removed row.

Libraries: ivstudio
Packages. foundation

PATCH 50.0138
Description: [studio] inspector crashes after having deleted a composite displayer.

Libraries. ilvstcharts
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Packages. charts

PATCH 50.0139

Description: TlvChartScrollInteractor can get stuck when reaching the maximum
and minimum values.

Libraries. ilvcharts
Packages. charts

PATCH 50.0140

Description: After using T1vSingleScaleDisplayer: :setStepLabels (), cCannot
come back to fixed steps.

Libraries. ilvstcharts
Packages. charts

PATCH 50.0141
Description: T1vGadgetItem doesnot display strings correctly in amultibyte locale.

Libraries: winviews, ilvgadgt
Packages: foundation

PATCH 50.0142

Description: Tooltips are not displayed on Windows in popup menus since patches 40.2114
and 50.0058.

Libraries. winviews
Packages: foundation

PATCH 50.0143

Description: Studio should not allow to delete a panel class being used in an application
notebook.

Libraries:. ilvstappli, ivstudio
Packages. gadgets, foundation

PATCH 50.0144
Description: Wrong transparency computation on 16 bits displays.

Libraries. xviews, mviews
Packages. foundation

PATCH 50.0145
Description: Crash in studio when adding a displayer to a chart with no displayers.

Libraries. ilvstcharts

Packages. charts
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PATCH 50.0146
Description: [pie] reading back a chart does not restore the pie slice labels font.

Libraries. ilvcharts
Packages. charts

PATCH 50.0147

Description: bad redraw when zooming in an area with a scale using crossing values and
chart cursor.

Libraries. ilvcharts
Packages. charts

PATCH 50.0148
Description: (Unix) Paste error with getClipboard () through Exceed.

Libraries: xviews, mviews
Packages:  foundation

PATCH 50.0150
Description: Grouping objectsin a 11vsmarset corrupts the focus chain.

Libraries. views
Packages: foundation

PATCH 50.0151

Description: [studio] T11vstringList selection mode inspector does not work correctly
since patch 50.0026.

Libraries. ilvadvgdt, ilvstgadget
Packages. gadgets

PATCH 50.0152
Description: Visual Studio wizard crashes when creating a project with an T1vGrapher.

Libraries:

Other files. tools/viewswiz50/viewswiz50.awx, tools/viewswiz50/
viewswiz50.hlp

Packages. foundation

PATCH 50.0153
Description: Unsatisfied symbolsfrom 1ibilvmgr in 1ibiljsgide.

Libraries. iljsgide

Packages. foundation
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PATCH 50.0154
Description: Matrix in Motif look and feel pastestwice at T1vButtonUp Of right button.

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0155

Description: The sensitivity of gadgets added to T1vGadgetMatrixItems iSNot
persistent.

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0156
Description: Using tooltips on gadget Items With Motif may lead to a crash.

Libraries. views
Packages: foundation

PATCH 50.0157

Description: [AppFrame] [windows] classinfo.odv ismissinginthe appframe.zrc
resourcefile.

Libraries:
Other files. data/res/appframe.rc
Packages: appframe

PATCH 50.0158

Description: T1vModeNotOr and I1vModeNotAnd useincorrect logical functions of the
GC (X11).

Libraries. xviews, mviews
Packages. foundation

PATCH 50.0159
Description: the tm_isdst field isn't initialized by the gvConverter.

Libraries: ilvijs
Packages. foundation

PATCH 50.0160
Description: [gadgets] [foundation] T1vMatrix crashes when deselecting a 5000 * 8 table.

Libraries. ilvadvgdt

Packages. gadgets
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PATCH 50.0161
Description: [variable] Bad behavior of the parser when the decimal symbol is',’ (comma).

Libraries: ilvvar31l
Packages. compat

PATCH 50.0162

Description: The I1vMakePolylineLInkInteractor hangswhen one double-clicks
outside a node.

Libraries. ilvgrapher
Packages.  grapher

PATCH 50.0163
Description: TlvManager::allIntersects only takesinto account the visible layers.

Libraries. ilvmgr
Packages: manager

PATCH 50.0164

Description: [prstudio] T1vAccessorParameter: :getChoices () receivesan
(inconsistant) null T1vvalueTypeClass object.

Libraries:. prstudio
Packages: protos

PATCH 50.0165
Description: Crash reading prototypes containing prototypesin amultidisplay environment.

Libraries. ilvproto
Packages. protos

PATCH 50.0166

Description: [matrix] Crash when selecting all rows of a5000 * 8 table (bottom-up
selection).

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0168

Description: T1vChartDragPointInteractor doesnot always take the validation
constraint into account.

Libraries. ilvcharts

Packages. charts
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PATCH 50.0169
Description: An additional " appears when the prototypeis saved in Views 5.0.

Libraries. ilvproto
Packages. protos

PATCH 50.0170

Description: Prototypes may not be able to retrieve properly their holder since patch
401118.

Libraries. prstudio
Packages. protos

PATCH 50.0171
Description: A prototype edition buffer is not marked as modified when the values of the
prototype are modified.

Libraries:. prstudio
Packages: protos

PATCH 50.0172
Description: [gadgets] Wrong gadget container background color in motif L&F.

Libraries. views
Packages: foundation

PATCH 50.0173
Description: Portage on HP 64 bits

Libraries. dbgadget, dbaccess
Packages. dataccess

PATCH 50.0174

Description: [printing] I1vPrintableGraphic doesnot print anything (bad transformer
setting).

Libraries. ilvprint
Packages. foundation

PATCH 50.0175
Description: [studio] Application panel inspector may not be refreshed properly and may
lead to a crash.

Libraries. ilvstappli

Packages. gadgets
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PATCH 50.0176
Description: Guides/Splitterslimitsin I1vGanttChartForm do not depend on L&F.

Libraries. ilvgantt
Packages. gantt

PATCH 50.0177
Description: [protos] FMM in I1vGroupMediator: :undoSubscription.

Libraries. ilvproto
Packages. protos

PATCH 50.0178

Description: Changing the values of aprototype that containsan 11vPrototypeAccessor
might mess up the I1vGroupInspector.

Libraries:. prstudio
Packages: protos

PATCH 50.0179

Description: In some circumstances, Studio can crash when you add or remove a class from
the application buffer.

Libraries: ilvstappli
Packages: gadgets

PATCH 50.0180

Description: [Sutdio] When a panel instance is reset in the application buffer, possible
subpanels are not taken into account.

Libraries. ilvstappli
Packages. gadgets

PATCH 50.0181
Description: Using adisplayer with child displayers, clicking its representation in the "Data
sets' tab makes studio crash.

Libraries: ivstudio
Packages. foundation

PATCH 50.0182
Description: New Feature: Disable the Marking Menu in Studio.

Libraries. ivstudio

Packages. foundation
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PATCH 50.0183

Description: TlvAbstractMatrix::scrollTo may not work asexpected if the matrix
has fixed rows.

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0184

Description: T1vChartGraphic: :removeOrdinateScales doesn't empty the
IlvAxisElement array.

Libraries. ilvcharts
Packages. charts

PATCH 50.0185
Description: [ps print] wrong scaling factor for Japanese.

Libraries: xviews,mviews, winviews
Packages: foundation

PATCH 50.0186

Description: T1vSingleScaleDisplayer: :getCursorByName iSnot protected against
unnamed cursors.

Libraries. ilvcharts
Packages:  charts

PATCH 50.0187
Description: Possible crash in Windows XP look & feel.

Libraries. ilvwxplook, ilvawxplook
Packages. foundation, gadgets

PATCH 50.0188

Description: FMR : an T1vCoordinateInfo that no longer existsis used during the
IlvChartGraphic deletion.

Libraries. ilvcharts
Packages. charts

PATCH 50.0189

Description: The data associated with the _i1vselected symbol set on achart graphic by
the I1vChartSelectInteractor may beinvalid.

Libraries. ilvcharts

Packages. charts
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PATCH 50.0190

Description: [Cursor] Label may not appear under some circumstances after patches
500.095 and 147.

Libraries. ilvcharts
Packages. charts

PATCH 50.0191
Description: T1vFileBrowser should prompt a messageif saving on an existing file.

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0192

Description: T1vGadget: :computePalettes changesthe T1vralette instanceif
antialiasing isnot T1vNoAntialiasingMode.

[gadgets] It isno longer possible to change the gadgetdefault colors using resources.
Libraries: views,winviews
Packages: foundation

PATCH 50.0193

Description: 1n some circumstances, Studio can generate an empty #include for an unknown
container class.

Libraries: ilvstappli
Packages: gadgets

PATCH 50.0194

Description: T1isimpleToggle edition does not work finein the first column of atable
gadget.

Libraries. dbgadget
Packages. dataccess

PATCH 50.0195
Description: TlvPrinterPreviewPort crashes drawing clipped transformed strings.

Libraries. ilvprint
Packages. foundation

PATCH 50.0196

Description: [EventPlayer] Popup menus are not getting pointer moved events inside a
modal window.

Libraries. winviews
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Packages. foundation

PATCH 50.0197
Description: T1iFormat roundsab inthe decimal part as +0, not as +1.

Libraries. dataccess
Packages. dataccess

PATCH 50.0198

Description: T1vPport: :drawLabel with IlvCenter horizontal alignment might shift 1
pixel to the left.

Libraries. winviews
Packages. foundation

PATCH 50.0199

Description: [Proto] Studio Inspector: need to validate on exit cell attribute, not just when
hitting Return.

Libraries:. prstudio
Packages: protos

PATCH 50.0200
Description: Resized T1vZoomableLabels do not appear in the preview.

Libraries: ilvprint
Packages: foundation

PATCH 50.0201

Description: TlvStereographicProjection and
IlvTransverseMercatorProjection areincorrectly serialized.

Libraries. ilvmaps
Packages. maps

PATCH 50.0202
Description: Tear-off menu doesn't get rid of the possible mnemonic in itstitle.

Libraries. ilvgadgt
Packages. foundation

PATCH 50.0203
Description: [Cursor] Cursor is clipped to the data area since | atest patches.

Libraries. ilvcharts

Packages. charts
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PATCH 50.0204
Description: [printing] Postscript page setup issue with color selector.

Libraries. ilvprtdlg
Packages. gadgets

PATCH 50.0205
Description: [printing] Wrong clipping when printing a manager view in keep-ratio mode
(default).

[printing] I1vRectangularScale does not print correctly.
Libraries. ilvprint, ilvmgrprint
Packages. foundation, manager

PATCH 50.0206
Description: [printing] Postscript options do not affect the preview and final psfile.

Libraries: ilvprtdlg
Packages: gadgets

PATCH 50.0207
Description: [printing] T1vRectangularScale doesnot printed correctly.

Libraries: display, ilvprint
Packages: foundation

PATCH 50.0208
Description: Views does not handle Unicode clipboard strings correctly.

Libraries. winviews
Packages. foundation

PATCH 50.0209

Description: [Protos] CTRL+M inspector shortcut on Solaris causes problems with the
Enter numpad key (numlock off).

Libraries:
Other files: studio/data/ivstudio/protos/interface.ilv
Packages. protos

PATCH 50.0210
Description: [Printing] Preview is not updated when changing the page orientation.

[printing] Postscript options do not affect the preview and final psfile.

Libraries. ilvprtdlg
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Packages. gadgets

PATCH 50.0211
Description: T1vSystemPort: :GetBitmapData does bad if rect not at 0, O.

Libraries. winviews
Packages. foundation

PATCH 50.0212
Description: [Printing] preview scrollbars do not support panel resizing.

Libraries. ilvprtdlg
Packages. gadgets

PATCH 50.0213

Description: Removing a data point may cause a crash at
IlvChartGraphic: :dataPointsRemoved.

Libraries. ilvcharts
Packages:  charts

PATCH 50.0214
Description: Using a scale with number of steps== 1 may lead to a crash.

Libraries. ivstudio
Packages: foundation

PATCH 50.0215
Description: [Pie chart] Floating point exception with a unique value equals to zero.

Libraries. ilvcharts
Packages. charts

PATCH 50.0216

Description: 11vMatrix (with fixed rows)/11vsheet doesnot scrollsto thefirst scrollable
row with PageUp.

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0217

Description: The two accel erators based on the F6 key and that allow to navigate through a
set of T1vviewFrame are swapped.

Libraries. ilvadvgdt

Packages. gadgets
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PATCH 50.0218
Description: Printing an T1vGanttChart to aprinter produces an unclipped output.

Libraries. ilvgantt
Packages. gantt

PATCH 50.0219

Description: T1ibbNavigator: ThesetSentive (I1True) method does not work for
user buttons.

Libraries. dbgadget
Packages. dataccess

PATCH 50.0220

Description: TlvManager::allContains doesn't check the visibility of the objects
stored in the highest layer.

Libraries. ilvmgr

Packages: manager

PATCH 50.0221

Description: Crash in studio when modifying a scale property and adding a new scal e before
applying it.

Libraries:. ilvstcharts

Packages:  charts

PATCH 50.0222

Description: T1vMapCompass: : computeNorths () does not check that the view
transformer is null.

Libraries. ilvmaps
Packages. maps

PATCH 50.0223

Description: T1vMapTileLoader ignore all features of tiles whose first featured is not be
ignored.

Libraries. ilvmaps
Packages. maps

PATCH 50.0224

Description: On Windows, points coordinates of polylines and polygons are still clipped to
[SHRT_MIN/2 , SHRT_MAX/2].

Libraries. winviews
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Packages. foundation

PATCH 50.0225
Description: [Windows]ZoomableLabels: very different fonts after arotation.

Libraries. winviews
Packages. foundation

PATCH 50.0226

Description: TlvPrinterPreviewDialog: :initData doesn't look for printing.dbmin
the resourcefile.

Libraries. ilvprtdlg, ivstudio

Other files: studio/data/res/ivfstudio.rc, studio/<pf>/
ivfstudio<exeExt>

Packages. gadgets, foundation

PATCH 50.0227
Description: I1vPSColorDevice doesn't transform correctly colorsinto shades of gray.

Libraries: display
Packages: foundation

PATCH 50.0228

Description: On Windows, T1vDisplay: :getClipboard doesn't lock the pool of char
alocated to store the data.

Libraries: ilvatext, ilvadvgdt, ilvmgr
Packages:  gadgets, manager

PATCH 50.0229
Description: Printed out strings may appear slightly truncated.

Libraries. winviews
Packages. foundation

PATCH 50.0230

Description: [Views5.0] T1vzoomInteractor doesnot take the into account the default
cursor given in the constructor.

Libraries. ilvmgr
Packages. manager

PATCH 50.0231
Description: [AnnoText] Memory leak seenin the T1vATHtm1Reader.

Libraries. ilvatext
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Packages. gadgets

PATCH 50.0232

Description: T1lvDvDocument::revert checks I1vDvMessageDialog: :popup ()
result incorrectly.

Libraries. ilvappframe, ilvappmgr
Packages. appframe

PATCH 50.0233
Description: [X11]Memory leaksin X11 intiaization.

Libraries. xviews, mviews
Packages. foundation

PATCH 50.0234
Description: [X11]Patch 50.0233 may cause a crash when the locale is not C.

Libraries:. xviews, mviews
Packages:  foundation

PATCH 50.0235
Description: [Windows] The Printer property dialog is not transient in ivfstudio.

Libraries. ivstudio
Packages: foundation

PATCH 50.0236

Description: Bad performance when doing bulk appendRow/del eteRow updated connected
toan I11ichartGraphic or to agadget with several data sources.

Libraries. dataccess, dbgadget
Packages. dataccess

PATCH 50.0237
Description: Tvstudio may crash when aprototypeinstance is saved as an ActiveX.

Libraries. views, ilvstdynact
Packages. foundation

PATCH 50.0238
Description: 11vview oObjects do not receive focus in/out events with Motif libraries.

Librariess mviews

Packages. foundation
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PATCH 50.0239

Description: [Protos][Regression] Studio crashes when deleting a prototype component
from the Group Inspector panel.

Libraries. prstudio
Packages. protos

PATCH 50.0241

Description: Scrolling an 11vsheet by clicking in the scrollable area of the scrollbar
Misses a row.

Libraries. ilvadvgdt
Packages. gadgets

PATCH 50.0242
Description: Crash deleting the container from the "focusin” callback of a button.

Libraries:. ilvgadgt
Packages: foundation

PATCH 50.0243
Description: The event player cannot replay events in subwindows of modal views.

Libraries: xviews, mviews
Packages:  foundation

PATCH 50.0244
Description: Round rectangle right and lower edges are not printed in preview.

Libraries. display
Packages. foundation

PATCH 50.0245
Description: [Studio] Layer names start with "Layer 1", but layer indexesin "Draw ->
Layer" start at O.

Libraries: ivstudio
Packages. foundation

PATCH 50.0246

Description: SDO Object model access to database do not release 11drequest objects
properly.

Libraries. ilvdbmaps

Packages. maps
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PATCH 50.0247
Description: Popup menu timer for hiding child popups failsif child popup has a child
itself.

Libraries. ilvgadgt
Packages. foundation

PATCH 50.0248
Description: [Gantt] [T1vRectangularsScale] Scaleticksand grid do not match exactly.

Libraries. winviews
Packages. foundation

PATCH 50.0249
Description: [Windows] Wrong font size since patch50.0225.

Libraries. winviews
Packages: foundation

PATCH 50.0250
Description: [Windows] I1vzZoomableIcon are not always printed correctly.

Libraries. winviews
Packages: foundation

PATCH 50.0252
Description: Popup menu timer for hiding child popups failsif child popup has a child
itself.

Libraries. ilvgadgt
Packages. foundation

PATCH 50.0253

Description: TlviWindowsDevice: :drawBitmap (pal, src, rect, point) iS
incorrect if the rectangle origin is not (0, 0).

Libraries. winviews
Packages. foundation

PATCH 50.0254

Description: [X1] On the Sun French/Spanish keyboards, Circumflex and Diaresis are not
handled in T1vTextField.

Libraries. xviews, mviews

Packages. foundation
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Release Notes for Version 5.0

This chapter describes the changes that have been madeto ILOG Views since version 4. You
will find information on the following topics:

¢ New Features

& Code Changes

New Features

The new features of ILOG Views 5.0 are described in:
Foundation Features

Sudio Features

Gadgets Features

Application Framework Features

Manager Features

Data Access Features

Charts Features

® 6 6 6 6 O 0o o

Gantt Features
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& Maps Features

Foundation Features

The following new features have been added for ILOG Views 5.0:

Filters

¢ |LOG Views Foundation now has image processing classes providing the same

functionality as the SVG filters:

IlvBlendFilter
IlvColorMatrixFilter
IlvSaturationFilter
IlvLuminanceToAlphaFilter
IlvHueRotateFilter
IlvComponentTransferFilter
IlvComposeFilter
IlvConvolutionFilter
IlvDisplaceFilter
IlvFloodFilter
IlvGaussianBlurFilter
IlvImageFilter
IlvLightingFilter
IlvDiffuseLightingFilter
IlvSpecularLightingFilter
IlvMergeFilter
IlvMorphologyFilter
IlvOffsetFilter
IlvTileFilter
IlvTurbulenceFilter

IlvFilterFlow

and supporting classes.

IlvTransferFunction
IlvBitmapDataKernel
IlvLightSource

IlvDistantLight
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IlvPointLight
IlvSpotLight
IlvPerlinNoise
IlvIdentityTransfer
IlvLinearTransfer
IlvTableTransfer
IlvDiscreteTransfer
IlvGammaTransfer

IlvIdentityTransfer

These filters can be described in an XML format similar to the SV G filters format. They
are applicable on 11vRGBBitmapbata images. They can be chained together to create
complex image processing commands.

& A graphicobject 11vFilteredGraphic how offersthe ability to apply filters (aflow of
image processing operations) on any I1vGraphic.

Printing

¢ |ILOG Views Foundation now has a printing framework to facilitate the printing in
ILOG Views applications. It consists of the following classes:

IlvPrintableDocument to define a document

I1lvPrintable to describe printable objects, with subclasses:

- IlvPrintableContainer

- IlvPrintableText

- IlvPrintableFormattedText
- I1lvPrintableGraphic

- IlvPrintableFrame

- IlvPrintableManager, I1vPrintableMgrview, and
IlvPrintableManagerLayer (available only with the manager package)

- I1lvPrintableComposite

IlvPrintableLayout for describing page layouts, with the predefined layouts:

- IlvPrintableLayoutOnePage
- IlvPrintableLayoutMultiplePages
- IlvPrintableLayoutIdentity

- IlvPrintableLayoutFixedSize
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e IlvPrinter to describe the printer, with subclasses:

- I1vPSPrinter
- IlviWindowsPrinter

e IlvPrintUnit with predefined units:

- IlvPrintPointUnit
- I1vPrintCMUnit
- IlvPrintInchUnit
- IlvPrintPicaUnit
e IlvPaperFormat With aselection of preregistered paper formats

o Predefined user interface dialogs T1vPostScriptPrinterDialog and
IlvPrinterPreviewDialog for choosing printers and their features. A print
preview dialog is also available, al of these in the Gadgets package.

& There aretwo new classes for low-level Windows printing management:
e IlvWindowsPrinterDCFactory

e IlvWindowsPrinterDCDialogFactory

Bitmap Data

& Thereisanew method to draw T1vBitmapData using alpha per pixel
IlvPort: :stretchBitmapData.

¢ A new bitmap streamer for TIFF images has been added, T1vTIFFStreamer

€ T1vRGBBitmapData how allows filtered image resampling using alarge varity of filters
for very high quality stretching. The new method is
I1vRGBBitmapData: :stretchSmooth.

I1vRGBBitmapData datacan be made alpha-premultiplied.

¢ A new classfor handling colormaps within I1vIndexedBitmapData has been added,
IlvColorMap.

Quantizers

There are new Quantizers for 24 bits, and indexed color conversion has been added:
¢ IlvFixedQuantizer for conversion to afixed colormap.

® IlvNetscapeQuantizer for conversion to the Netscape colormap.

The new hierarchy for quantizersis now:

€ IlvQuantizer
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IlvFixedQuantizer
IlvQuickQuantizer

IlvNetscapeQuantizer

* & & o

I1lvWUQuantizer

® PostScript Devices

The PostScript device can how make use of PostScript level 2 features (thisis now the
default mode).

The PostScript device when in level 2 can now encode images in various formats using
encoders derived from I1vPostScriptEncoder. Three encoders are provided:

€ T1vASCITHexEncoder (convertsinput bytesin hexadecimal, produces 2 characters
from 1 input byte).

€ T1vASCII8SEncoder (convert input bytesto visible charset, produces 5 characters
from 4 input bytes).

4 TIlvRunLengthEncoder (convertsinput bytesto binary run length encoded data;
compression depends on input).

The default encoder isnow T1vASCITHexEncoder for level 1 and T11vASCITI85Encoder
for level 2. These encoders can be linked together, for example, to ascii85 encode run length
encoded data.

Windows Transparency

On Windows platforms 98, 2000, and XP, T1vview can be partially transparent when it isa
top window, and full transparency can be defined by a color value. New Windows
functionality such as Layered Windows can be used. The new methods are:

€ IlvAbstractView: :setOpacity
IlvAbstractView: :getOpacity
IlvAbstractView: : setTransparentColorKey

IlvAbstractView: :getTransparentColorKey

* 6 o o

IlvAbstractView: : setLayered

These methods have no effect on other platforms.

Graphic Rendering

The ILOG Views low-level drawing primitives APl has been enhanced to support
transparency and anti-aliasing. These features are accessible from different levels:. at the port
(11vport) level for aglobal setting, or at the palette (T11vPalette) level for alocal setting.
See the sections Alpha Value and Anti-AliasingMode of the Foundation User Manual’s
chapter "llvResource: The Graphic Resources Class™ for details.
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Note that these features are available only on Windows platforms with GDI+ installed. See
the section Using GDI+ Features with ILOG Viewsin Appendix B of the Foundation User’s
Manual for details.

Studio Features

ILOG Studio now integrates a new printing package that replaces the mechanism previously
used.

Gadgets Features

Look and Feel Management
& Thelook and feel of Windows XP is now supported on platforms running Windows XP.

& You can specify thelook and feel at different levels: T11vGadget,
IlvGadgetContainer, and I1vDisplay. Thismakesit possible to mix several look
and feelsin the same application. See the section "Gadgets Look and Feels" of the
Gadgets User Manual for details.

& Itisnow possibleto create your own look and feel handler. See the section "Gadgets
Look and Feels ™ of the Gadgets User Manual for details.

& Existing Look and Feels (Motif, Windows 3.11, Windows95, and Windows XP) have
been put in separate librairies. You may have to modify your makefilesin order to link
your applications. See the Code Changes section Look and Feel Management for details.

llvViewFrame

Thelook of the 11vviewFrame objects has changed for Motif to look like a Motif
component.

Docking Panes

Thelook of the docking handles has changed. Now, a docking handle displays the title of its
related pane. However, you can keep the old ook by using the static function method
IlvDockingHandlePane: :UseDefaul tHandlePanes.

llvComboBox and llvScrolledComboBox

When the list of an T1vComboBox is opened, the openList calback is called. See the
IlvComboBox: : OpenListSymbol function for details.

When the list of an T1vComboBox is opened, the keyboard focusiis still located on the text
field, making it possible to enter characters whilethelist is shown. The selection of thelist is
then changed accordingly to what is located in the text field.
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IlvMatrix

Itis now possible to edit a matrix item with any T11vGraphic instance. Seethe class
TIlvMatrixItemEditor for details.

Application Framework Features

The Application Framework Editor has a new Palette entry, ‘Dialogs, to add dialog boxes
and windows to your application.

For full details on the Editor see the chapter “Using the Application Framework Editor” in
the ILOG Views Application Framework User’s Manual.

Manager Features

Manager Layers

It is now possible to modify the rendering of a manager layer by specifying an alphavalue
and an anti-aliasing mode.

The alpha value controls the transparency of the layer, making it possible to see objects
through layers drawn below this layer. Seethe I1vManagerLayer: : setAlpha member
function for details.

Theantialiasing mode setsthe anti-aliasing mode of the whole layer, a more convenient
way than setting the anti-aliasing mode of each object of the layer. Seethe
IlvManagerLayer: :setAntialiasingMode method for details.

See the Manager Layers section in the Manager User’s Manual (2D Graphics/ Basic
Manager Features) for more details.

Data Access Features
The following new features have been added for ILOG Views 5.0:
& Thereisanew database access: DB2.

& Dbschemaisintegrated into the SQL Tables palette of DbStudio or Data Access SQL
plugin.
& The multidb format for DbStudio is replaced by the Data A ccess plugins and

ivfstudio.

Charts Features

IlvBarChartDisplayer, llvHiLoChartDisplayer
You can now set the width of the barsto be proportional to the whole width of the chart:
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€ IlvBarChartDisplayer::setWidthPercent
€ IlvHiLoChartDisplayer: :setWidthPercent

IlvChartCyclicPointSet
Thereisanew cyclic data set class, I1vChartCyclicPointSet.

llvChartGradientPointinfo
Thereisanew classto define color gradients, T1vChartGradientPointInfo.

llvXMLChartData
Thereis anew class to read data sets from an XML file, 11vxMLChartData.

Gantt Features
Following is a summary of the new features for ILOG Views Gantt in version 5.0:

¢ Thereissupport for time scalesin I1vGanttChartForm. YOU can use the time scales
provided by the Foundation modulein 11vGanttChartForm. A dynamic calendar grid,
IlvGanttCalendarGrid, iSalso provided. See the sample <ILVHOME> /samples/
gantt/calendar for details.

¢ New grid family classes have been added to the Gantt chart.

& Thelook of the grids displayed in the grapher views can be customized by specifying an
IlvPalette.

¢ Thegrapher views have thin borders.
4 You can enable tooltips on Gantt nodes.

® TlvGanttSelectInteractor alowsyou select and move not only Gantt nodes but
also Gantt lines.

¢ Thehandle between grapher views has been changed froman 11vFilledRectangle tO
an T1vReliefDiamond in order to get a better look and to better use the space between
grapher views.

¢ A new calback “Work Area” is added to T1vGanttcChart to notify the work area
changes.

¢ New samples have been added. Existing samples have been considerably revised.

¢ ThelLOG Views Gantt Users Manua has been extensively rewritten.

Maps Features

This section describes the main changes that have been made to ILOG Views Maps since
version 4.
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See aso the ILOG Views Maps Classes code changes.
Load-On-Demand Framework
The following features are added:

& A new class has been added to simplify the creation of tile loaders: the
IlvMapTileLoader class. Thisclassincludesall standard rendering features and tile
loading for al tile loaders.

€ TIlvLookAheadFeatureIterator: Definestheinterfacefor
IlvMapFeatureIterator that hasthe ability to fetch the ID of the next feature before
reading it, allowing you to skip the next featureif it is not needed.

¢ Load-On-Demand for Shapefiles: Support for |oad-on-demand on ESRI Shapefiles has
been added. To load Shapefiles on demand, a new type of file, with the . i dx extension,
has been introduced. These files contain the spatial indexes associated with Shapefiles.

The following classes have been added to support the load-on-demand feature:

e IlvShapeFileIndex: To read the newly introduced ShapeFile index files (. shx
extension)

e IlvShapeSpatialIndex: TO read the newly introduced spatial index files (. idx
extension).

e IlvShapeFileTileLoader: Thetileloader for Shapefiles, to create load-on-
demand layers when used in conjunction with T1vTiledLayer.

e IlvShapeFileLayer: A tiled Shapefile layer that can besavedinan .i1v file.
e TheIlvshapeFileTiler classhasbeen added to generate the spatial index files.
New Supported Formats
Support for loading single GeoTIFF files or tiled GeoTIFF files has been added.
The following classes have been added to support the GeoTIFF format:
€ IlvGeoTIFFReader: Reader for GeoTIFF files.
€ I1vGeoTIFFTileLoader: Tileloader for loading tiled GeoTIFF files.
& TIlvGeoTIFFLayer: A tiled GeoTIFF layer that can be saved in an .ilv file.
€ TI1vGeoTIFFTiler: A classto producetiled GeoTIFF file.

The ability to read image files has been added. The image formats supported are those
supported by ILOG Views.

& TIlvImageReader: A classtoread singleimagefile.

& IlvImageTileLoader: A classtoread aset of images, each image representing atile
in atiled data set.
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& IlvImageLayer. A tiledimagelayer that can besavedinan .i1v file.

File Name Resolution

A file name resolver mechanism has been added. This mechanism is used by thetile loaders
to resolve pathnames.

The following classes support the file name resolver mechanism:
€ IlvMapDataPathManager: A classto manage path resolvers.

& TIlvDefaultDataPathResolver: A default implementation of an
IlvMapDataPathResolver Which looksfor filesin adirectory.

& IlvMapDataPathResolver: The abstract base classfor al path resolvers.

Oracle Spatial

& IlvObjectSDOWriter::setCheckingStringAttributes enables/disablesthe
checking of String attributes.

€ IlvDefaultObjectSDOTileLoader: :setRequestParameters SetSsome
parameters in order to tune the request that isused by an 11vTile.

€ I1vObjectSDOUtil::GetLayerExtent computesthe extent (the global bounding
box of al geometries) of an SDO layer.

Samples
¢ A new sampleto show how to read and tile ShapeFile files has been added.
¢ A new sampleto show how to read and tile GeoTIFF files has been added.

¢ A new sample to show how to read mutiresolution tiled data set (Shapefile and image)
has been added.

# The shape sample can now tile a Shapefile for oad-on-demand.

MapBuilder

The following new features are added:

¢ The MapBuilder is now able to read multiresolution data found in the data CD.
¢ An Overview has been added.

& The new legend enabl es the dragging/dropping of layersto change their order of
appearance.

& The new menu active on the legend allows you to dynamically change the rendering
palette of each layer.

¢ It now supports GeoTIFF and Shapefile [oad-on-demand.
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Code Changes
This section presents changes in the code of existing ILOG Views and ILOG Script for
ILOG Views classes since version 4.
¢ |1LOG Views Foundation Classes

ILOG Views Charts Classes

ILOG Views Gadgets Classes

ILOG Views Gantt Chart Classes

* & & o

ILOG Views Maps Classes

ILOG Views Foundation Classes

ILOG Views Foundation Classes include the following code changes.

llvColorMap
€ IlvIndexedBitmapData NOW USES I1lvColorMap

¢ The quantizers have been modularized and use T1vColorMap.

IlvDisplay
The method T1vDisplay: :getBitmap Now has asecond parameter. The prototype
becomes:

IlvBitmap* getBitmap (const char* name, IlBoolean read = IlFalse) const;

When set to T1True, the read parameter indicates that if the bitmap has not been found in
theinternal display cachelist, it must be read using the T1vDisplay: : readBitmap
method.

llvPort

On Windows platforms, the T1vport: : drawTrans formedString method has changed
its behavior to work around a display bug. This may result in smaller strings being
displayed. Asaside effect, the T1vzoomableLabel objects, which use this method, may
have their drawing changed the same way.

llvBitmap

Since Views 5.0, on the Windows platform when the display depth is> 8, the T1vBitmap
constructor that accepts an 11vBitmapbData internally uses a DIBSection of the depth of
the 11vBitmapData. Thishasthe following consequences:

¢ When using an 11vIndexedBitmapData, the memory allocated is now one-fourth of
the memory allocated in ILOG Views5.0.
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& Thesize and the number of created 11vBitmap instancesislimited only by the available
system memory, whereas in previous ILOG Views versions there was a limit given by
the system (approx 48 Megabytes by T1vBitmap and alimit of 192 Megabytes for all
I1vBitmap instances on Windows NT).

& Performanceis far better when using 11vIndexedBitmapData Since NO conversion to
true color is needed anymore.

& TheI1vBitmap depthisno longer aways equal to the display depth, so using a depth-8
I1vBitmap to draw into using ILOG Views can give unexpected results since the
colormap of the underlying DIBSection might not exactly match the colors used to draw.

llvView

On Windows, the following methods are no longer taking the task bar into account:
€ IlvView::ensurelInScreen

® IlvView::moveToScreen

llvWindowsDevice

The constructor of T11viwindowsDevice has an additional optional parameterof type
IlviWwindowsPrinterFactory.

llvWindowsVirtualDevice

& Thereturntype of T11viwindowsVirtualDevice: :getHDC iShow an HDC and no
longer an unsigned long.

¢ Thetype of the parameter of I1vWindowsvVirtualDevice: : setHDC iShow an HDC
and no longer an unsigned long.

Typedef Changes

The typedef of T11viwindowProc has changed so that a port on Windows 64 bits will be
possible later. It is now:

typedef IlBoolean (* IlvWindowProc) (IlvAbstractView* view,
IlvSystemView hwnd,
IlvMsgParam iMessage,
IlvWParam wParam,
IlvLParam lParam,
I1Any& returned,
I1Any userArg) ;

IlvMsgParam, I1viWParam, and I1vLParam are three new typedefs that are respectively
equivalent to unsigned int, unsigned int, and long for Windows 32 bits. That meansthat a
code written for the previous version of ILOG Views still compiles and runs. However, the
types will be different for Windows 64bits, and you should use the new types to be portable.

Note that the port on Windows64bits is not yet available, and even not precisely planned.
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ILOG Views Charts Classes

ILOG Views Old Charts Classes

The new charts (contained in the i 1vcharts library) can now be used with the old charts
(contained in the views31 library provided in the compatibility package). To make the old
and the new charts compatible, the following classes and macros have been renamed:

€ IlvChartDataConstructor -> Ilv31ChartDataConstructor
IlvChartDataClassInfo -> Ilv31ChartDataClassInfo
IlvPreRegisterChartDataClass -> Ilv31PreRegisterChartDataClass

IlvPostRegisterChartDataClass -> Ilv31PostRegisterChartDataClass

* 6 o o

IlvPredefinedChartDataIOMembers ->
Ilv3lPredefinedChartDataIOMembers

To be able to use both the old and the new charts at the same time, check for occurrences of
these classes and macros in your old charts code and change them.

Note: You do not need to modify your old charts code if you do not want to use both the old
charts and the new ones at the same time.

Deprecated Methods
The following methods are deprecated:

llvAbstractChartDisplayer

€ IlvAbstractChartDisplayer::getOrdinateInfo ()

€ IlvAbstractScaleDisplayer::getCoordinateInfo (I1lUInt)
llvSingleScaleDisplayer

€ IlvSingleScaleDisplayer::getCoordinateInfo (I1lUInt)
€ IlvSingleScaleDisplayer::getGridDisplayer ()

€ IlvSingleScaleDisplayer::setGridDisplayer (IlvAbstractGridDisplayer*
)

llvMultiScaleDisplayer
€ IlvMultiScaleDisplayer::getCoordinateInfo(I1UInt)
llvScaleStepsUpdater

® IlvScaleStepsUpdater::getCoordinateInfo ()
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ILOG Views Gadgets Classes

llvMessageLabel

An IlvMessageLabel Object with anon-null thickness now drawsits frame asarelief
rectangle. The label is shifted accordingly. To keep the old behavior, that is, to remove the
frame of the T1vMessageLabel, call the I1vGadget: : setThickness method with 0 as
aparameter, or call the T1vGadget : : showFrame method with T1False as aparameter.

Look and Feel Management

ILOG Views now provides its predefined look and feels through separated librairies. This
means that you will probably have to modify your makefilesin order to add the look
libraries your application uses. If you are using shared libraries, you may only need to
compile with the 1LVvNODEFAULTLOOK Symbol to avoid linking with the look and feel
libraries.

See the Gadgets Look and Feel section in the User Manual (Controls/Gadgets/Part |1/
Understanding Gadgets) for details. The following tables present the new libraries:

Table3.1 Look Librariesfor Windows platforms

Standard Gadgets Advanced Gadgets
Look . ;
Library Library
Motif ilvmlook.lib ilvamlook.1lib
Windows 3.11 ilvwlook.lib ilvawlook.lib
Windows 95 ilvw95look. 1lib, ilvaw95look.1lib,
ilvwlook.1lib ilvawlook.1lib
Windows XP ilvwxplook.lib, ilvawxplook.lib,
ilvw95look.1lib, ilvaw95look.1lib,
ilvwlook.lib ilvawlook.1lib

Table 3.2 Look Libraries for UNIX platforms

Standard Gadgets Advanced Gadgets
Look . .

Library Library
Motif libilvmlook libilvamlook
Windows 3.11 libilvwlook libilvawlook
Windows 95 1libilvw95100k, libilvaw951o0k,

libilvwlook libilvawlook
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Look and Feel Callback

The callback called when the look is changed (see
IlvDisplay: :addChangeLookCallback) ishow called once when an application using
look and fedl islaunched.

Docking Panes

The management of docking bars has changed somewhat compared to ILOG Views4.0. The
new behavior ensures that the last visible docking bar of a dockable container should be
elastic. Thismeansthat if the dockable container isresized, only thislast docking bar will be
resized.

ILOG Views Gantt Chart Classes

New Classes and Methods
IlvGanttChart hasthe following new classes:
IlvGanttHorizontalGridImpl
IlvGanttHorizontalGrid
IlvGanttLineGrid
IlvGanttLineReliefGrid
IlvGanttResourceGrid

IlvGanttRowGrid

® 6 6 O 6 o o

IlvGanttCalendarGrid

IlvGanttChart hasthe following new public methods:
IlvPalette* getGridPalette();

void setGridPalette(IlvPalette*);

I1lBoolean isDrawingGrapherViewBorders() ;
void setDrawingGrapherViewBorders (I1Boolean) ;
I1Symbol* WorkAreaCallbackType() ;

I1lvRect& getWorkArea (IlvRect& area);

IlvRect& getLineArea (IlvRect& area) ;

® 6 6 6 O 6 0 o

IlvGraphic* setLineGrid(IlvGraphic* grid, IlvBoolean redraw, IlInt
layer) ;

.

IlvGraphic* getLineGrid() ;

.

IlvGraphic* setRowGrid(IlvGraphic* grid, IlvBoolean redraw, IlInt
layer) ;

€ IlvGraphic* getRowGrid() const;
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€ void setDoubleBuffering(IlBoolean) ;

€ IlBoolean isDoubleBuffering() const;

Incompatibilities

The signatures of the following methods of T11vGanttChartForm have been changed:

* IlvGraphic* setCompositeScale(IlvGraphic*, IlBoolean, IlBoolean);
* IlvGraphic* getCompositeScale() const;

L 2 IlvGraphic* setCompositeGrid(IlvGraphic*, IlvBoolean);

* IlvGraphic* getCompositeGrid() const;

Behavior Changes

IlvGanttChart: :rowResized (I1lvUShort, IlvPos) calsthe new “Work Ared’
callback.

The default layer for the Gantt linesis changed from O to 1.

€ void addLine(IlvGanttLine* line, IlBoolean redraw,int layer=1);

€ void insertlLine(IlvGanttLine* line, I1lUShort row, IlBoolean
redraw, int layer=1);

Deprecated Methods
IlvGanttChartForm: : setCompositeGrid () isdeprecated. Use
IlvGanttChart: :setRowGrid () instead.

Samples

In the sample folder of the Gantt module, <TL.VHOME>/ samples/gantt, the 1oad and
month samples are considerably revised. Two new samples, simple and calendar, are
added.

Bug Fixes

ILOG Views Gantt had the following bugs that are now fixed:

€ TlvGanttChart: :psDump dumping the grids of the grapher views.

& TheIlvGanttcChart could not be properly resized before it was added to a container.

& TlvGanttChart could not switch to mono view interactively by dragging the handle
between the grapher views.

ILOG Views Maps Classes

llvShapeFileReader
Constructors have been modified to take the . shx file into account:

IBM ILOG VIEwWSs V5.3 — RELEASE NOTES



*
*

Code Changes

Added a shxFileName parameter to the I1vShapeFileReader constructor.

Added a shxIndex to the I1vShapeFileReader constructor.

IlvObjectSDOWriter

To resolve incompatibility, removed a documented protected method from
IlvObjectSDOWriter. TheI1lvObjectSDOWriter: :getSDOGeometryString method
has been removed. This class no longer uses Strings in order to save geometriesinto Oracle

Spatial.
Bug Fixes

ILOG Views Maps had the following bugs that are now fixed:

4

® & 6 6 6 o o * & 6 o o
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The default T1vObjectSDOKeyExtractor not supporting the Number Oracle type.
I1vObjectSDOReader Not reading more than 65536 points.
IlvObjectSDOFeatureIterator returning the wrong Multi Area geometries.
IlvMapGeneralPath: bad bounding box computation under specific circumstances.
Could not use Oracle 9i Spatial.

Read/write of some 11vsDoLayer/I1vObjectSDOLayer layers might haveledto a
crash.

SDO sample requiring an ILOG DB Link license.

The shape reader crashing when the file contained valued geometries without values.
IlvMapLoader not taking the insertion layer into account.
IlvMapsRegisterLicense Not registering the license correctly.
DoubleAttributeReader: : read (Shapefile reader) not switching to C locale.
Could not customize the T1vbefaultObjectSDOTileloader.

The constructor I11vobjectSDOLayer (I1vSDOTileLoader*, IlvTileCache*,
const char*) not working.

FMM in I1vMapCoordinateViewer.

Crash when swapping/del eting/creating multiple buffers.

Problem when a view attached to an ILOG Maps GUI component was del eted.
IlvObjectSDOWriter: :populateIndexes could misbehave.

Application consuming too much cpu time when using load-on-demand.
Runtime Licenses not initialized properly with library i 1vdbmaps.

I1vObjectsDowriter forgetting to raise some errors.
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€ TI1vObjectSDOUtil::IsUsing816 not working correctly.
& Thedestructor of T1vMapCoordviewer could produce MLK.
& CrashinIlvTileController: :updateViews.

& TIlvMapGeneralPath badly handling palette (side effects).
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Release Notes for Version 4.0.2

These rel ease notes describe the changes that have been made to ILOG Views since version
4.0.1. The document describes:

¢ New Features

& System Changes

New Features

The ILOG Views Component Suite includes the following new featuresin Version 4.0.2:
¢ \\eb Deployment
¢ Prototypes

Web Deployment

The new ILOG Views Web Deployment package allows you to create Web applications
from ILOG Views applications.

For details refer to the Web Deployment documentation.
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Severa new features have been added to the Prototypes package:
¢ Switch Accessor

& Cut/Copy/Paste

4 Animation Timer On/Off

Switch Accessor
A new control accessor has been added.

The Switch accessor (class T1vswitchAccessor) implements a switch statement.
Parameters

& Switch: An expression that should return an integer. Depending on its result, the attribute
0...N will be assigned the value of the parameter.

& case0: Must be an attribute of the prototype or the value "". If Switch evaluatesto o, the
behaviors of the attribute named in this parameter will be executed.

& case l: Must be an attribute of the prototype or the value "". If Switch evaluatesto 1, the
behaviors of the attribute named in this parameter will be executed.

& case N: Must be an attribute of the prototype or the value "". If Switch evaluatesto a
value equal to or greater than N, the behaviors of the attribute named in this parameter
will be executed.

Example
A traffic light with varying settings can be implemented like this:

Value Integer
do
Switch Value
case 0 doRed
case 1 doOrange
case 2 doGreen
case 3 Anomaly

doRed

do
greenEllipse.visible=False
orangeellipse.visible=False
redEllipse.visible=True
doBlink=False

doOrange

do
greenEllipse.visible=False
orangeellipse.visible=True
redEllipse.visible=False
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doBlink=False

doGreen

do
greenEllipse.visible=True
orangeellipse.visible=False
redEllipse.visible=False
doBlink=False

Anomaly

do
greenEllipse.visible=False
orangeellipse.visible=True
redEllipse.visible=False
doBlink=true

doBlink Boolean

do
blink orangeEllipse.visible 150

For information on additional control and other accessors, refer to the ILOG Views 2D
Graphics User’s Manual, “ Predefined Accessors.”

Cut/Copy/Paste

Cut/copy/paste has been added to the Edit facilities when using ILOG Studio for Prototype
extension functions.

In the Group Inspector Panel you will now find cut/copy/paste commands in the Edit menu
of the Attributes and Behavior pages.

4 You can copy or cut awhole attribute and its behaviors by selecting thefirst line of an
attributes tree and selecting Edit > Copy or Edit > Cut.

& On the Attributes page you can copy or cut asingle behavior by selecting the behavior's
line and then Edit > Copy or Edit > Cut.

& You can paste the contents of the attribute clipboard by first selecting aline where you
want the attribute to be inserted and then selecting Edit > Paste.

For full details on other Edit functions, refer to the ILOG Views 2D Graphics User’s
Manual, “Creating and Using Prototypes.”

Animation Timer On/Off

An on/off toggle has been added for animation timers. This additional control is available
from the View menu of the ILOG Studio Menu Bar with Prototypes Extension.

This additional command is described below.
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ToggleTimers

Label Toggle Animation Timers

Path View menu

Category prototypes

Action Turns on or off the animation timers of the prototype’s animation accessors,
thereby allowing you to edit the prototype and then test its behavior.

For the other prototypes commands, refer to the ILOG Views 2D Graphics User’s Manual,
“Prototypes Extension Commands.”

System Changes

102

The ILOG Views Component Suite includes the following system changesin Version 4.0.2:
& Platform Adjustments
& Note for Unix Users: Motif and Shared Libraries

Platform Adjustments

In a constant effort to provide you with the best development environments available, ILOG
continually updates its supported platforms. This effort to follow the evolution of compilers
and operating systems provides opportunities to add platform upgrades as well as
abandoning from time to time the support of older platforms. We publish here the list of
ports that will be modified in the next release of the ILOG Views Component Suite, Version
4.0.2.

New Ports
This release includes:

¢ A new 64-bit port for Sun UltraSparcStation users. This port is named
ultrasparc64_5_5.0.

¢ A new library format for HP 11 usersthat supports the -aa compilation flag. Thisportis
named hp32_11_3.30 and includes the following library formats:
static_pic_mt_AA and shared_mt_AA.

Warning for SGI Users

Thisrelease (Version 4.0.2) will be thefinal release of the ILOG Views Component Suite
that supports SGI. Future releases of the ILOG Views Component Suite coming in 2002 will
not provide a port for SGI.
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ILOG Views 4.0.2 will continue to be supported on the SGI platform until June 2003. We
encourage users of the ILOG Views Component Suite on an SGI platform to prepare a
migration plan on another platform supported by the ILOG Views Component Suite, or to
contact their ILOG representative if the maintenance period needs extension.

Platform Upgrades

The following ports are provided for the last timein this release of the ILOG Views
Component Suite (Version 4.0.2). The next release will contiue to deliver a port for these

operation systems, but for a more recent version of compiler and operating system:
¢ msvch

¢ hp 10_1.0

® sparc_5_4.2

® rs6000_4.3_3.6

€ i86_linux2_glibc2.1_egcsl.1
L 4

alpha_4_ 6.1

Note for Unix Users: Motif and Shared Libraries

The use of 1ibmviews (Motif-based) is deprecated in shared library format. Since Version
4.0, all shared libraries provided by ILOG Views are built using 1ibxviews and are
incompatible with 1ibmviews. Upon request at your ILOG support site, ILOG can provide
anew set of shared libraries built on top of 1ibmviews for your platform. For future
versions, 1ibmviews Will be provided only asastatic library and will not be supported in
shared format.
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